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Introduction

 Before You Read This Guide
Thank you for choosing CLIP STUDIO MODELER. The following describes points to keep in mind when reading this
guide.

Structure and Contents of This Guide 
The screens in CLIP STUDIO MODELER are as follows:

 3D Object Setup screen

 3D Character Setup screen

This guide is divided into sections about each screen, along with a section about information common to multiple screens. Below is a list of the 
sections and their contents.

3D Object Setup Screen
The "3D Object Setup Screen"  section describes the features and operating instructions for each palette in the 3D Object Setup screen. All fea-
tures in the 3D Object Setup screen can be used in the trial version.

 "Configuration of the 3D Object Setup screen" 

 "Functions in the 3D Object Setup Screen" 

 "Tool List (3D Object Setup Screen)" 

 "Object configuration palette" 

 "Object Information Palette" 

3D Character Setup Screen
The "3D Character Setup Screen"  section describes the features and operating instructions for each palette in the 3D Character Setup screen. 
All features in the 3D Character Setup screen can be used in the trial version.

 "Configuration of the 3D Character Setup Screen" 

 "Functions in the 3D Character Setup Screen" 

 "Tool List (3D Character Setup Screen)" 

 "Character Configuration Palette" 

 "Character Information Palette" 

 "Default Bone Mapping Mode" 

 "Standard Bone Creation Mode" 

 "Skirt Settings Mode" 

Common Features
The "Common Features"  section describes items that appear in all screens.

 "Tool-type Palettes" 

 "Navigator Palette" 

 "Camera Settings Palette" 

 "View Settings Palette" 

 "Material Palette" 
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 "Menu" 

 "Shortcut List" 

Regarding the Content of This Guide
 This guide (including in electronic data format) has been written and edited based on product programs current as of August 2018 and may 

differ from actual product program specifications.

 The screenshots in this guide show the model currently in development. The specifications may differ from the actual program model 
released for this product.

Regarding Operations Described in This Guide
Operations in this guide are described based on the Windows version unless otherwise noted.

If you are a macOS user, replace and read as indicated below. Operations are equivalent on both Windows and macOS when substituted as fol-
lows.

Symbols Used in This Guide
In this guide, symbols are used for operation-related comments. The symbols have the following meaning:

Trademarks and Copyrights
 CELSYS, CLIP STUDIO MODELER, HexaSuper and other CELSYS products are trademarks or registered trademarks of CELSYS,Inc.

 The names and logos of Apple, Macintosh and QuickTime are trademarks or registered trademarks of Apple Inc. in the United States and 
other countries.

 Microsoft and Windows are trademarks or registered trademarks of the Microsoft Corporation in the United States and other countries.

 All other company names and product names described herein are trademarks or registered trademarks of their respective holders.

 No part of this guide (including data) may be reproduced or copied in any form or by any means without permission from the copyright 
holder, except when so required by law.

Windows macOS

[Alt] key [Option] key

[Ctrl] key [Command] key

[Enter] key [Return] key

[Backspace] key [Delete] key

Right click [control] key + click

Right drag [control]] key + drag

Indicates items that may be easily mistaken or matters to be aware of when using CLIP STUDIO MODELER.

Indicates tips and supplementary information useful when using CLIP STUDIO MODELER.
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References
References to other parts of this guide as well as other documents are indicated by using "" (double quotation marks).
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3D Object Setup 
Screen
This section describes the following items in the 3D Object Setup screen. 

 Configuration of the 3D Object Setup screen

 Functions in the 3D Object Setup Screen

 Tool List (3D Object Setup Screen)

 Object configuration palette

 Object Information Palette



Configuration of the 3D 
Object Setup screen
The 3D Object Setup screen in CLIP STUDIO MODELER is displayed by selecting [3D object] in the [New] 
dialog box.
This section describes the configuration of the 3D Object Setup screen.

 About the 3D Object Setup Screen
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Configuration of the 3D Object Setup screen

 About the 3D Object Setup Screen
The 3D Object Setup screen is the screen displayed when [3D object] is selected in the [New] dialog box.

In this screen, you can load 3D data and set up a 3D object that can be used in CLIP STUDIO PAINT. Settings to switch
between multiple textures or move specific parts with a slider can be added. Setting these allows you to customize the
display of 3D object materials in CLIP STUDIO PAINT.

Camera angles and [Node] (part) displays can also be set in the 3D data, and can then be selected in CLIP STUDIO PAINT.
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The 3D Object Setup screen in CLIP STUDIO MODELER consists of the following main components.

(1) Command Bar
Allows you to use various functions by clicking the icons. For information on each item in the [Command Bar], see "Command Bar" .

(2) Palette Dock
Area accommodating multiple palettes.

(3) Palette
Screen for configuring settings. There are various types of palettes. In this screen, palettes are accommodated in palette docks. However, 
they can also be displayed individually as windows or dialog boxes.

For information on palettes that can be used in the 3D object setup screen, see "Palettes in the 3D Object Setup screen" .

(4) Document Window
Area for displaying and performing operations for models being created. For information on each item in the [Document] window, see 
"Document Window" .
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Command Bar
The area on the upper part of the main window where function icons are arranged is called "Command Bar". Clicking an icon on the [Com-
mand Bar] is equivalent to executing a menu function.

(1) Start CLIP STUDIO
Start CLIP STUDIO. CLIP STUDIO is a tool for supporting creative activities.

(2) New
The [New] dialog box is displayed. You can select the type of work and create a new work.

(3) Open
Opens a saved file, etc. for re-editing.

(4) Save
Saves the edited file newly or under the same name.

(5) Undo
Clicking it cancels the last operation.

(6) Redo
Clicking it redoes the undone operation.

(7) Reset camera
Returns the viewpoint of the camera to its initial status.

(8) CLIP STUDIO MODELER Support
The web browser is launched and the CLIP STUDIO MODELER Support site is displayed.
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Document Window
The [Document] window is an area for displaying and performing operations for 3D objects being created.

(1) Tabs for switching between documents
Displays the file names of the models being edited. Clicking the tabs allows you to switch the file or view to edit.

(2) Show / Hide point
Displays/hides the highest point of the 3D object.
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(3) Show / Hide edge
Displays/hides the edge of the 3D object.

(4) Show / Hide normals
Displays/hides the normals of the 3D object.

(5) Show / Hide bone
Displays/hides the bones of the 3D object.

(6) Show / Hide physics object
Cannot be used.

(7) Enable / Disable physics operation
Cannot be used.

(8) Document
The area for editing 3D objects.

(9) World coordinate axes
The baseline coordinate axes of the 3D space. There are three axes: the X axis (red), the Y axis (green) and the Z axis (blue).
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Palettes in the 3D Object Setup screen
The following palettes are displayed in the 3D Object Setup screen.

Tool Palette
Various tools are arranged as buttons. Clicking a button enables the tool for use. For details on the 
[Tool] palette, see "Tool Palette" .

Sub tool palette
Each tool comes with preconfigured settings called [Sub tool]. Select a sub tool in accordance with the 
purpose of the tool to use. For details on the [Sub tool] palette, see "Sub Tool Palette" .

Tool property Palette
Allows you to adjust the settings of the sub tool selected on the [Sub Tool] palette. For details on the 
[Tool Property] palette, see "Tool Property Palette" .

Object configuration palette
The [Object configuration] palette can be used to manage [Node], [Material], [Layout] and [Movabil-
ity] items. For details on the [Object configuration] palette, see "Object configuration palette" .

Object Information Palette
The [Object information] palette is used to configure advanced settings for items selected on the 
[Object configuration] palette. For details on the [Object information] palette, see "Object Information 
Palette" .

Navigator Palette
The [Navigator] palette is used to adjust the camera angle by dragging the rectangle on the palette. You 
can also change the camera distance and switch the projection method and perspective using the icons 
and sliders on the palette. For details on the [Navigator] palette, see "Navigator Palette" .

Camera Settings Palette
The [Camera settings] palette is used to change the camera angle and distance and switch the projec-
tion method and perspective. For details on the [Camera settings] palette, see "Camera Settings Pal-
ette" .

View Settings Palette
The [View Settings] palette is used to configure grid count and screen view settings such as [Drawing 
effects] and the [Shader]. For details on the [View Settings] palette, see "View Settings Palette" .

Material Palettes
The [Material] palette is used to manage various materials in the CLIP STUDIO series. For details on 
the [Material] palette, see "Material Palette" .
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Functions in the 3D 
Object Setup Screen
This section describes how to set up 3D object materials that can be used in CLIP STUDIO PAINT using the 
3D Object Setup screen.

 Importing 3D Materials

 Editing and Setting Materials

 Setting a Layout

 Setting Movability Parts

 Setting Information

 Setting Camera Angles

 Capturing a Thumbnail

 Setting Movability Parts
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Functions in the 3D Object Setup Screen

 Importing 3D Materials
This section explains how to import 3D files in the 3D Object Setup screen. The following file formats can be imported.

1 Select the file to be imported
Import an image file in the [Object configuration] palette.

(1) Select [Node] from the group on the [Object configuration] palette.

(2) Click [Add from file].

(3) When the dialog box for opening a file is displayed, select the file to be imported and click [Open].

2 The file is imported
The selected file is imported in CLIP STUDIO MODELER.

(1) The [Node] of the imported file is displayed in the [List] of [Nodes].

(2) The imported 3D file is displayed in the [Document] window.

File formats that can be imported CLIP STUDIO MODELER file format (extension: csmf), fbx, 6kt, 6kh, lwo, lws, obj

Select [Add from material] to display the [Node] dialog box, where 3D files can be imported from materials on the 
[Material] palette. Nothing is displayed in the [Node] dialog if there are no materials corresponding to 3D objects 
on the [Material] palette.

When a 3D file for which bones are set is imported to the [Object configuration] palette, other 3D files cannot be 
imported. If you have imported the wrong 3D file, select the [Edit] menu → [Undo].
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 Editing and Setting Materials
The [Surface materials] of 3D objects can be edited to change settings such as the color of the 3D object.

Adding a material panel folder
Before editing a [Surface material], duplicate the [Material panel folder] (add a new one). Duplicating the folder means that the original [Sur-
face material] can be restored later after editing the [Surface material].

1 Select a material panel folder
Select the [Material panel folder] to be duplicated.

(1) Click [Material] in the group on the [Object configuration] palette.

(2) Select the [Material panel folder] to be duplicated in the list.

2 Duplicate the material panel folder
Duplicate the [Material panel folder].

(1) Click [Duplicate node].

(2) The [Material panel folder] is duplicated in the [List].

 Multiple 3D files can be added in the [Object configuration] palette. For example, a 3D file for a room can be 
imported, followed by 3D files for furniture.

 The node hierarchy level of the imported 3D object can be edited. For information on how to edit this, see 
"Node operations" .
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Exporting Textures
[Surface materials] (textures) in [Material panel folders] can be exported as images in PNG format. Exported images can be edited in image 
editing software.

1 Select a texture
Select the [Surface material] to be exported from the [Object configuration] palette.

(1) Click [Material] in the group on the [Object configuration] palette.

(2) Display the [Material panel folder] containing the [Surface material] to be exported in the [List].

(3) Select the [Surface material].

2 Exporting Textures
Click [Export texture] in the [Object information] palette.

When the [Save As] dialog box is displayed, specify a location and save the image.

The exported file can be imported into CLIP STUDIO MODELER after editing with image editing software.
For information on importing, see "Changing Textures" .
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Changing Textures
[Surface materials] (textures) in [Material panel folders] can be converted to other images.

The following file formats are supported.

1 Select a texture
Select the [Surface material] to be converted from the [Object configuration] palette.

(1) Click [Material] in the group on the [Object configuration] palette.

(2) Display the [Material panel folder] containing the [Surface material] to be converted in the [List].

(3) Select the [Surface material].

2 Import a texture
You can import a new texture for the selected [Surface material].

(1) Click [Import texture] in the [Object information] palette. When the dialog box for selecting a file is displayed, select the image file 
to be used for the texture.

File formats that can be imported BMP, JPG, PNG, TIFF, TGA

If you want to keep the original [Surface material], select the [Material panel folder] in the [Object configuration] 
palette and click [Duplicate node].
The [Material panel folder] containing the original [Surface material] is duplicated.
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(2) The [Surface material] changes and the new texture is applied to [Import texture] in the [Object information] palette.

(3) The new texture is applied to the 3D object in the [Document] window.

Editing Textures in CLIP STUDIO PAINT
If both CLIP STUDIO PAINT and CLIP STUDIO MODELER are installed on your computer, you can start CLIP STUDIO PAINT and edit 
[Surface materials] (textures) there.

1 Select a texture
Select the [Surface material] to be edited from the [Object configuration] palette.

(1) Click [Material] in the group on the [Object configuration] palette.

(2) Display the [Material panel folder] containing the [Surface material] to be converted in the [List].

(3) Select the [Surface material] in the [Material panel folder] to be edited in the list.

You can also import a texture by copying the image for the desired texture to the clipboard in software such as an 
image editing program, then clicking [Paste texture] in the [Object information] palette.

If you want to keep the original [Surface material], select the [Material panel folder] in the [Object configuration] 
palette and click [Duplicate node].
The [Material panel folder] containing the original [Surface material] is duplicated.
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2 Start CLIP STUDIO PAINT
Click [Edit in PAINT] in the [Object information] palette.

3 Edit in CLIP STUDIO PAINT
CLIP STUDIO PAINT opens in synchronized edit mode and the texture is displayed on the canvas.

The [Editing texture] window is also displayed.

When you edit a texture in CLIP STUDIO PAINT, the edits are automatically applied in the [Editing texture] window.

 For instructions on using CLIP STUDIO PAINT, see “CLIP STUDIO PAINT User Guide”.

 If the edits are not applied in CLIP STUDIO PAINT, turn on [Enable Auto Save] in the [File] menu of CLIP STU-
DIO PAINT.

 If the texture being edited is not displayed in the [Editing texture] window, change the camera angle of the 
[Editing texture] window. For information on how to change this, see "Setting Camera Angles".

 If the texture is edited with multiple layers in CLIP STUDIO PAINT, the [Surface material] is saved with the lay-
ers merged.

The edited item can be checked 

in the [Editing texture] window 

of CLIP STUDIO MODELER.

Edit the texture in CLIP STUDIO PAINT.
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4 Exit the editing screen
Exit CLIP STUDIO PAINT or close the window of the [Surface material] being edited in CLIP STUDIO PAINT. CLIP STUDIO MOD-
ELER returns to the normal view.

Changing the display of materials
Multiple [Material panel folders] can be kept on the [Object configuration] palette.

This section explains how to switch the [Material panel folders] displayed in the [Document] window.

Select [Material] in the group on the [Object configuration] palette and click [Visible/Invisible] for the [Material panel folder] to be displayed.

Parts for which you have clicked [Visible/Invisible] are displayed.

Only one [Material panel folder] can be displayed in the [Document] window.

It is not possible to edit [Material panel folders] only by clicking [Visible/Invisible] and displaying them in the 
[Document] window.
[Material panel folders] can be selected and their contents can be edited by meeting the following conditions.

 Display the [Material panel folder] in the [Document] window.

 Click to select the following items in the [Material panel folder] displayed in the [Object configuration] palette.
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 Setting a Layout
Set layouts for 3D objects. [Layouts] are used to save the position and display status of parts in a 3D object. If the part
allocation of a 3D object is changed, it can be restored to its last saved state by applying the [Layout].

Saving a Layout
Add a [Layout] to the [Project configuration] palette and save the allocation of the [Nodes] (parts) of the 3D object.

1 Adding a Layout
Create a [Layout] in the [Object configuration] palette.

(1) Select [Layout] from the group on the [Object configuration] palette.

(2) Click [Add new].

(3) A layout is added.

2 Configuring Part Display Settings
Set the [Nodes] to be displayed in the [Object information] palette.

(1) Click [Set display state of node].
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(2) Click the [Visible/Invisible] icon to hide [Nodes] that you do not want to display and show [Nodes] that you want to display.

3 Select the tool
Select the [Move] tool from the [Tool] palette and select [Move parts] from the [Sub Tool] palette.

4 Select the part to be moved
Select the [Node] to be moved from the [Object configuration] palette.

(1) Select [Node] from the group on the [Object configuration] palette.

(2) Select the [Node] to be moved.

5 Change the part allocation
Move the [Node] by dragging the arrows and rings of the manipulators in the [Document] window.

 If the item you want to set is not displayed when [Set display state of node] is opened, check the [List] in the 
[Node] group of the [Object configuration] palette.

 When a [Node] folder is closed in the [List], [Nodes] below that folder are not displayed in [Set display state of 
node]. Make sure that the folder containing the [Node] to be configured is open and displayed in the [List].
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Move other [Nodes] to change their allocation if necessary.

6 Saving a Layout
Save [Layouts] for 3D objects.

(1) Select [Layout] from the group on the [Object configuration] palette.

(2) Select the [Layout] added in step 1 from the [Object configuration] palette.

(3) Click [Save 3D object layout].

 For information on the [Move parts] tool, see "Move parts" .

 If the [Node] cannot be selected properly, select [Node] in the group in the [Object configuration] palette and 
select the [Node] to be moved from the [List]. Select [Layout] in the group again when saving the [Layout].

 To check whether a [Layout] is registered, see "Applying a Layout" .

 To change the [Layout] name or create a thumbnail, see "Setting Item Information in a Group" .
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Applying a Layout
Apply a [Layout] to the 3D object in the [Document] window.

1 Select a layout
Select the [Layout] to be applied from the [Object configuration] palette.

(1) Select [Layout] from the group on the [Object configuration] palette.

(2) Select the [Layout] to be applied from the [List].

(3) Click [Apply layout to 3D object].

2 The layout is applied
The selected [Layout] is applied in the [Document] window.
CLIP STUDIO MODELER USER GUIDE 24



Functions in the 3D Object Setup Screen > Setting Angles
 Setting Angles
Set the angles of 3D objects. [Angle] is used to save the camera angles for displaying 3D objects and the display set-
tings of [Nodes] (parts). If the camera of a 3D object is changed, it can be restored to its last saved state by applying
the [Angle].

Save angle
Add an [Angle] to the [Project configuration] palette and save the camera angle for displaying 3D objects and the display settings of [Nodes].

1 Add an angle
Create an [Angle] in the [Object configuration] palette.

(1) Select [Angle] from the group on the [Object configuration] palette.

(2) Click [Add new].

(3) The [Angle] is added.

2 Changing the camera angle
Change the camera angle applied to a 3D object in the [Document] window.

(1) Select the [View] tool from the [Tool] palette and select [Camera orientation from the [Sub Tool] palette.
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(2) Drag in the [Document] window to set the camera angle to be applied to a 3D object.

3 Configuring Part Display Settings
Set the [Nodes] to be displayed in the [Object information] palette.

(1) Click [Set display state of node].

(2) Click the [Visible/Invisible] icon to hide [Nodes] that you do not want to display and show [Nodes] that you want to display.

 Use the [Camera position] and [Camera distance] sub tools too if necessary. For information on the functions 
of each sub tool, see "View Tool" .

 To change the camera angle without using the [View] tool, see "Setting Camera Angles" .

If the item you want to set is not displayed when [Set display state of node] is opened, check the [List] in the 
[Node] group of the [Object configuration] palette.
When a [Node] folder is closed in the [List], [Nodes] below that folder are not displayed in [Set display state of 
node]. Make sure that the folder containing the [Node] to be configured is open and displayed in the [List].
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4 Save angle
Save the [Angle] to the 3D object.

(1) Select the [Angle] added in step 1 from the [Object configuration] palette.

(2) Click [Save object angle].

 To check whether an [Angle] is registered, see "Applying an Angle" .

 To change the [Angle] name or create a thumbnail, see "Setting Item Information in a Group" .
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Applying an Angle
Apply an [Angle] to the 3D object in the [Document] window.

1 Select the angle
Select the [Angle] to be applied from the [Object configuration] palette.

(1) Select [Angle] from the group on the [Object configuration] palette.

(2) Select the [Angle] to be applied from the [List].

(3) Click [Apply angle to object].

2 The angle is applied
The selected [Angle] is applied in the [Document] window.
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 Setting Movability Parts
Record movement or rotation of the [Nodes] (parts) of 3D objects so that they can be operated by moving the [Nodes]
in CLIP STUDIO PAINT.

Add a [Movability] part to the [Object configuration] palette and record the movement of the [Nodes] of the 3D object.
-

1 Add a movability part
Create a [Movability] part in the [Object configuration] palette.

(1) Select [Movability] from the group on the [Object configuration] palette.

(2) Click [Add new].

(3) The [Movability] part is added.
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2 Record the movement of the node
Select a [Node] in the [Object information] palette and record the movement.

(1) Select the [Node] to be moved from [Target node].

(2) Click [Turn this node into a movable node ] to confirm a [Target node ].

(3) Move the slider to the right end.

(4) Input the [Position] and [Rotation] values to adjust the position of the [Node]. The results of the adjustment can be checked in the 
[Document] window.

(5) Click [Add key frame].

(6) The [Node] position is recorded in the slider and a [Key frame] (▲) is added below the slider.

 If it is difficult to move the [Node], you can select the [Move parts] sub tool and edit it using the manipulators 
in the [Document] window. For details, see "Move parts" .

 To change and check the camera angle of the [Document] window, see "Setting Camera Angles" .

 In case the value for the [Rotation center] was changed, and a value for [Rotation] is set, the [Node] rotates 
according to the position set for the [Rotation center]. In addition, when selecting the [Move part origin point] 
sub tool, the position of the “rotation center” moves accordingly. For details, see "Move part origin point" .

 Checking [Use the node origin as the center of rotation] and setting a value for [Rotation] the node is rotated 
with its origin at the center. The origin of the [node] can be edited by operating the manipulator in the [Docu-
ment] window through the [Move part origin point] sub tool. For details, see "Move part origin point" .

The [Node] position 
has been changed 
according to the direction 
in which the laptop cover opens.
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3 Playing movability parts
Drag the slider in the [Object information] palette left and right.

The [Node] in the [Document] window moves with the slider.

If you are satisfied with the result, the setting process is now complete.

In the top picture, the laptop cover is down. If there are any movement issues like this, proceed to the next step.
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4 Adjust the movement of the part
In the [Object information] palette, create an additional key frame and adjust the movement of the [Node].

(1) Drag the slider to the position where the movement of the [Node] is odd.

(2) Input the [Position] and [Rotation] values to adjust the [Node] to its natural position. The results of the adjustment can be checked in 
the [Document] window.

(3) Click [Add key frame].

(4) The [Node] position is recorded in the slider and the [Key frame] is added below the slider.

(5) Repeat steps 3-4 if necessary until the movement becomes natural.

Adjust the [Node] position.
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 Setting Information
Set various information on 3D objects to be displayed in the [Material] palette and the settings screen of CLIP STUDIO
PAINT.

Setting 3D object information
Set 3D object information. You can set a material name and thumbnail to be displayed when the 3D object is registered in the [Material] pal-
ette.

The thumbnail and material name set here are also displayed in CLIP STUDIO when the 3D object is published in CLIP STUDIO ASSETS.

1 Select the group
 Select [Sketch] in the [Object configuration] palette. 

2 Set the thumbnail
Add a thumbnail for the 3D object in the [Object information] palette.

(1) Click [Thumbnail].

(2) Capture a thumbnail in the [Capture thumbnail] window. For information on operations in the [Capture thumbnail] window, see 
→"Capturing a Thumbnail" .

(3) The captured thumbnail is applied.
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3 Set the name of the 3D object
Input information on the 3D object in the [Object information] palette.

(1) Click the name of the 3D object displayed in [Name]. When an input field is displayed, input the new name.

(2) Click the area to the right of [Comment]. When an input field is displayed, input a comment.

Setting Item Information in a Group
Set item names and thumbnails that can be configured in CLIP STUDIO PAINT for 3D object elements such as [Materials], [Layouts] and 
[Movability] parts.

This explanation uses [Material panel folders] as an example, but elements such as [Layouts] and [Movability] parts can be set in the same way.

1 Select a material panel folder
Select the [Material panel folder] for which you want to edit the information from the [Object configuration] palette.

(1) Click [Material] in the group on the [Object configuration] palette.

(2) Select the [Material panel folder] to be edited in the list.

Comments are not displayed in CLIP STUDIO and CLIP STUDIO PAINT.
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2 Set the thumbnail
Add a thumbnail for the [Material panel folder] in the [Object information] palette.

(1) Click [Thumbnail].

(2) Capture a thumbnail in the [Capture thumbnail] window. For information on operations in the [Capture thumbnail] window, see 
→"Capturing a Thumbnail" .

(3) The captured thumbnail is applied.

3 Set information for the material panel folder
Input information for the [Material panel folder] in the [Object information] palette.

(1) Click the name displayed in [Name]. When an input field is displayed, input the new name.

(2) Click the area to the right of [Comment]. When an input field is displayed, input a comment.

 Comments are not displayed in CLIP STUDIO and CLIP STUDIO PAINT.

 When the name is changed in the [Object information] palette, the name changes in the [Object configuration] 
palette and [Material panel folder] too.
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 Setting Camera Angles
The camera angle can be changed at times such as when saving works in the [Document] window, by using the mouse
with tools other than the [View] tool.

These operations can also be used to change the camera angle in the [Capture thumbnail] window.

Camera orientation
Drag to change the camera orientation.

If this does not change the camera angle, press the [Space] key while dragging.

Camera position
Drag with the mouse wheel to move the camera directly up, down, left or right.

If this does not change the camera angle, press the [Space] key while dragging with the mouse wheel.

Drag

Drag the wheel
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Camera distance
Right click and drag to move the camera back and forth.

If this does not change the camera angle, press the [Space] key while right clicking and dragging.

Right drag
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 Capturing a Thumbnail
This section explains operations in the [Capture thumbnail] window that is displayed when capturing a thumbnail for a
material. The captured thumbnail is displayed in the [Material] palette and the screen for setting materials in CLIP STU-
DIO PAINT.

1 Display the [Capture thumbnail] window
Click [Thumbnail] in the [Object information] palette.

2 Capturing a Thumbnail
Capture the thumbnail in the [Capture thumbnail] window.

(1) Drag in the [Preview area] to set the desired angle for the thumbnail. The area displayed will be used for the thumbnail.

For [Movability], [Layout], [Angle], etc., capture a thumbnail of the applied settings in the [Document] window to 
create a thumbnail that clearly shows the setting information.
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(2) Click [Complete].

3 The thumbnail is complete
The thumbnail in the [Object information] palette changes to the one captured in the [Capture thumbnail] window.

For information on how to set the angle, see "Setting Camera Angles" .

To change a thumbnail, click [Thumbnail] on the [Object information] palette to display the [Capture thumbnail] 
window.
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 Saving a 3D Object
Save a work you have set up. Works can be saved in the following three ways.

Saving Project Data
Saving as a project file to be edited in CLIP STUDIO MODELER. It is recommended that you save works in this format first so that they can 
be edited again in CLIP STUDIO MODELER.

From the [File] menu, select [Save]. When the [Save As] dialog box is displayed, select [CLIP STUDIO MODELER object file (*.csmo)] in 
[File type] and save the work.

Saving in a Format for Importing in other CLIP STUDIO Products
Saving 3D files in CLIP STUDIO format enables them to be imported as 3D materials in CLIP STUDIO PAINT.

From the [File] menu, select [Save as]. When the [Save As] dialog box is displayed, select [CLIP STUDIO 3D object file (*.cs3o)] in [File 
type] and save the work.

Saving Project Data Saving as a project file to be edited in CLIP STUDIO MODELER.

Saving in a Format for Importing in 
other CLIP STUDIO Products

Saving as a 3D file that can be imported to CLIP STUDIO PAINT.

Registering to the Material Palette
Registering as a 3D material in the [Material] palette or CLIP STUDIO. 3D materials can 
be imported from CLIP STUDIO PAINT's [Material] palette immediately. They can also 
be published on CLIP STUDIO ASSETS.

Project files cannot be imported in CLIP STUDIO PAINT as they are. To use works in CLIP STUDIO PAINT, see 
"Saving in a Format for Importing in other CLIP STUDIO Products"  or "Registering to the Material Palette" .
CLIP STUDIO MODELER USER GUIDE 40



Functions in the 3D Object Setup Screen > Saving a 3D Object > Registering to the Material Palette
Registering to the Material Palette
Register works set up in CLIP STUDIO MODELER as 3D materials in the [Material] palette or CLIP STUDIO. Registered 3D materials can 
be imported from CLIP STUDIO PAINT's [Material] palette immediately. They can also be published in CLIP STUDIO ASSETS.

1 Select the command
From the [File] menu, select [Register as new material].

2 Set the material information
Set the material information and the location for saving the material in the [Material property] dialog box.

(1) Check [Material name]. To change it, change the input.

(2) Configure settings such as [Location to save material] and [Search tag].

(3) Click [OK].

For information on how to publish materials in CLIP STUDIO ASSETS, see "CLIP STUDIO TIPS"→"How to publish 
materials to ASSETS[Windows/macOS]".
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Tool List (3D Object 
Setup Screen)
This section introduces the functions and settings in the [Tool] palette of the 3D Object Setup screen by tool.
For information on how to use the [Tool] palette, see Tool-type Palettes.

 View Tool

 Move Tool



Tool List (3D Object Setup Screen) > View Tool > Camera orientation
Tool List (3D Object Setup Screen)

 View Tool
The sub tools of the [View] tool change the view of the [Document] window.

Camera orientation
The camera orientation can be changed by dragging in the [Document] window.

Tool Property
Below are the setting items on the [Tool Property] palette when the [Camera orientation] sub tool is selected.

(1)  Fixed rotation angle
When you finish dragging at an angle that is almost directly forward or sideways, the camera orientation is fixed directly forward or side-
on. The projection method changes to [Parallel projection] when the camera orientation is forward or side-on.

It can also be changed by dragging while pressing the [Space] key when using other tools.
If you are running this software on a device that uses full-width characters, make sure that the input is set to Eng-
lish or half-width characters when using this function.

Drag
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Camera position
The camera can be moved, up, down, left or right in the screen by dragging in the [Document] window.

Camera distance
The camera can be moved back and forth in the screen by dragging in the [Document] window.

It can also be moved in the same way by dragging with the mouse wheel while pressing the [Space] key when 
using other tools.
If you are running this software on a device that uses full-width characters, make sure that the input is set to Eng-
lish or half-width characters when using this function.

It can also be moved in the same way by right clicking and dragging while pressing the [Space] key when using 
other tools.
If you are running this software on a device that uses full-width characters, make sure that the input is set to Eng-
lish or half-width characters when using this function.

Drag

Drag
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 Move Tool
The sub tools of the [Move] tool can be used to move [Nodes] (parts) or sketches.

Move sketch
Selecting this displays the control points and outlines of the sketches imported in the [Sketch] group of the [Object configuration] palette. Drag-
ging a control point allows you to transform the sketch. Dragging a sketch allows you to move the sketch to a new position.

(1) Same size scale
Drag to scale up/down while keeping the original aspect ratio of the sketch.

(2) Stretch (Width)
Drag to change the width of the sketch.

(3) Stretch (Height)
Drag to change the height of the sketch.
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Move parts
Click a [Node] (part) in the [Document] window to select the [Node].

When a [Node] is selected, manipulators are displayed at the origin of the [Node], enabling the position and orientation of the [Node] to be set.

(1) Controller
The center point where the arrows intersect is the origin of the [Node].

Click and drag the controller (blue circle) to move the [Node] freely.

When the [Movability] parts group from the [Object configuration] palette is selected,  it is displayed at the rotation center of the [Node], 
instead of at the origin of the [Node].

(2) Move (x)
Click and drag the red arrow (X axis) to move the selected [Node] in the direction of the arrow.

(3) Move (y)
Click and drag the green arrow (Y axis) to move the selected [Node] in the direction of the arrow.

(4) Move (z)
Click and drag the blue arrow (Z axis) to move the selected [Node] in the direction of the arrow.

(5) Rotate back and forth (x)
Click and drag the [Red] ring. The selected [Node] rotates in the direction of the ring.

(6) Rotate horizontally (y)
Click and drag the [Green] ring. The selected [Node] rotates in the direction of the ring.

(7) Rotate left/right (z)
Click and drag the blue ring. The selected [Node] rotates in the direction of the ring.

 Parts that are not displayed in the [Document] window cannot be edited.

 [Nodes] can also be edited by selecting them from the [Node] group of the [Object configuration] palette and 
editing them with the [Move parts] tool.
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Move part origin point
When selecting the [Move part origin point] sub tool, manipulators are displayed at the origin of 3D objects and nodes (parts), and the position 
of the origin can be adjusted.

(1) Move (x)
Click and drag the red arrow (x axis) to move the origin in the direction of the arrow.

(2) Move (y)
Click and drag the green arrow (y axis) to move the origin in the direction of the arrow.

(3) Move (z)
Click and drag the blue arrow (z axis) to move the origin in the direction of the arrow.

In case [Movability] parts are selected in a [Group] in the [Object configuration] palette, and if [Use the node origin 
as the center of rotation] is unchecked in the [Object information] palette, the manipulator is displayed at the 
position of the rotation center, instead of at the origin of the [node]. When operating the manipulator, the position 
of the rotation center can be adjusted. The position of the origin can be adjusted in the same way. For details, see 
"When a movability part is selected" .
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Also, if a bounding box is displayed on the 3D object or node (part), click the point on the bounding box to move the origin of the 3D object to 
the clicked position.

 When selecting the [Move part origin point] sub tool, only [Sketches], [Nodes] and [Movability] parts in the 
[Object configuration] palette can be edited. Editing in other groups cannot be done.

 When a [Node] or [Movability] part is selected inside a [Group] in the [Object configuration] palette, the origin 
of a 3D object or a node can be set in the [Object information] palette. For details, see "When a node is 
selected"  and "When a movability part is selected" .

Click
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Move 3D object
Selecting the [Move 3D object] sub tool displays manipulators at the original of the 3D object, enabling the position and angle of the 3D object 
to be adjusted.

(1) Move (x)
Click and drag the pink arrow (x axis) to move the 3D object in the direction of the arrow.

(2) Move (y)
Click and drag the green arrow (y axis) to move the 3D object in the direction of the arrow.

(3) Move (z)
Click and drag the blue arrow (z axis) to move the 3D object in the direction of the arrow.

(4) Rotate back and forth (x)
Click and drag the pink ring. The 3D object rotates in the direction of the ring.

(5) Rotate horizontally (y)
Click and drag the [Green] ring. The 3D object rotates in the direction of the ring.

(6) Rotate left/right (z)
Click and drag the blue ring. The 3D object rotates in the direction of the ring.

Only [Sketches] and [Nodes] on the [Object configuration] palette can be edited when the [Move 3D object] sub 
tool is selected. Editing in other groups cannot be done.
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Object configuration pal-
ette
The [Object configuration] palette can be used to manage [Nodes], [Materials], [Layouts], [Angles], etc. for 
3D objects. This section describes the functions of the [Object configuration] palette.

 Functions in the Object Configuration Palette



Object configuration palette > Functions in the Object Configuration Palette
Object configuration palette

 Functions in the Object Configuration Palette
This section describes the common functions of the [Object configuration] palette.

A. Groups
The settings that can be configured on the [Object configuration] palette are divided into groups.

Click each group button to switch the settings in the [List] and [Command Bar].

(1) Sketch
Configure settings related to sketch image files.

(2) Node
Import files to be used as 3D objects and manage the [Nodes] of 3D objects.

(3) Material
Manage materials (textures) for 3D objects.

(4) Layout
Manage the [Layouts] of 3D objects. [Layout] is used to set the allocation of parts in a 3D object.

(5) Angle
Manage the [Angles] of 3D objects. [Angle] is used to set the camera angles for displaying 3D objects and configure the display settings of 
[Nodes].

(6) Movability
Manage the [Movability] of 3D objects. [Movability] is a setting for moving and rotating specific [Nodes].

B. List
Clicking the group buttons in [Group] displays advanced settings for the selected group.

The settings vary depending on the selected group. For details, see the items indicated below.

C. Open Folder/Close Folder
Open and close folders. Clicking this icon toggles the folder between open and closed.

Sketch See "Sketch" .

Node See "Node" .

Material See "Material" .

Layout See "Layout" .

Angle See "Angle" .

Movability See "Movability" .

A

B C

D E F

G
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D. Visible/Invisible
Set display state of folders and sketches. Clicking this icon toggles between display and hide.

E. Element name
The name of each element such as nodes and textures. It may be possible to rename this by double clicking.

F. Lock
Enable/disable editing Clicking this icon toggles the layer between enabling and disabling editing.

G. Command Bar
3D files can be imported to the [List] and various operations from the [List] can be performed.

The displayed items vary depending on the selected group. For details, see the items indicated below.

Sketch See "Sketch" .

Node See "Node" .

Material See "Material" .

Layout See "Layout" .

Angle See "Angle" .

Movability See "Movability" .
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Sketch
When [Sketch] is selected from [Group], a sketch is imported to the [Document] window and management items are displayed.

This section describes the functions of the [List] and [Command Bar]. For information on other functions, see "Functions in the Object Config-
uration Palette" .

List
(1) Sketch folder

The folder where sketch images are stored. Multiple sketch images can be imported and managed. It is not possible to delete the [Sketch 
folder] or change its name.

(2) Sketch image
The image imported as a reference for the creation of a 3D object. Click [Visible/Invisible] for [Sketch image] to toggle between display-
ing and hiding the sketch in the [Document] window. Only one sketch can be displayed at once. Double click the name to rename the 
sketch.

Command Bar
(1) Add new

Cannot be used.

(2) Add from file
Imports an image file to be used as a sketch in the [Object configuration] palette.

(3) Add from material
Cannot be used.

(4) Duplicate node
Duplicates a sketch selected from the [List].

(5) Delete node
Deletes a sketch selected from the [List].

File formats that can be 
imported

BMP, JPG, PNG, TIFF, TGA

Command Bar
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Node
Select [Node] in [Group] to import files to be used as 3D objects and manage the [Nodes] of 3D objects.

This section describes the functions of the [List] and [Command Bar]. For information on other functions, see "Functions in the Object Config-
uration Palette" .

List
The [Nodes] of 3D objects are displayed in a node tree. The node tree shows the hierarchical structure of the nodes.

(1) Root node folder
The folder where all [Nodes] of a 3D object are stored. It is not possible to delete the [Root node folder] or change its name.

(2) Node
3D data parts imported in the [Object configuration] palette. Items consisting of multiple parts are displayed as multiple nodes.

Multiple folders may be stored as one node depending on the structure of the imported 3D data.

For information on how to operate [Nodes], see "Node operations" .

Command Bar
(1) Add new

Adds an empty [Node] that contains no 3D data.

(2) Add from file
Imports an image file for the 3D object in the [Object configuration] palette.

A [Node] for the imported file is added below the [Node] selected in the [List].

(3) Add from material
Materials in the [Material] palette can be added to the [Object configuration] palette.

Clicking these displays the [Node] dialog box. Select a material in the [Material] palette and click [OK] to import the part.

A [Node] for the imported file is added below the [Node] selected in the [List].

When a [Node] folder is closed in the list, the display status of the [Nodes] below that folder cannot be set when 
setting the [Layout] or [Angle].
Make sure that the [Node] to be configured is displayed in the [List].

File formats that can be 
imported

CLIP STUDIO MODELER file format (extension: csmf), fbx, 6kt, 6kh, lwo, lws, obj

Materials are not displayed in the [Node] dialog box if there are no materials that can be used as [Nodes].

Command Bar
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(4) Delete node
Deletes the selected [Node]. When a parent [Node] is deleted, all child [Nodes] below it are deleted too.

Node operations
You can change the display order and create folders for [Nodes] in the [Object configuration] palette.

Change node position
Select a [Node] and drag it to the position where you want to move it. You cannot move nodes within the same level in the hierarchy.

Change parent-child relationship of nodes
Select a [Node] and drag it to the [Node] that you want to set as the parent.

The [Node] where you dragged the selected [Node] becomes a folder, and the node that you dragged becomes a child of that [Node].

 It is not possible to delete [Nodes] for which movability is set, or parent [Nodes] of these [Nodes].

 It is not possible to delete [Nodes] created from a 3D file in which bones are set.

Drag

Drag
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Material
Select [Material] in [Group] to manage materials (textures) for 3D objects.

This section describes the functions of the [List] and [Command Bar]. For information on other functions, see "Functions in the Object Config-
uration Palette" .

List
(1) Material folder

The folder where all [Material panel folders] are stored. Multiple [Material panel folders] can be created and saved. It is not possible to 
delete the [Material folder] or change its name.

(2) Material panel folder
Folders for managing the [Surface materials] of [Materials]. Materials can be set as visible or invisible. The names of these folders are dis-
played in the screen for selecting materials in CLIP STUDIO PAINT.

(3) Surface material
[Surface materials] (textures) used for [Materials]. Multiple [Surface materials] may be used for some 3D objects.

Command Bar
(1) Add new

Cannot be used.

(2) Add from file
Cannot be used.

(3) Add from material
Cannot be used.

(4) Merge same materials
This feature allows matching materials to be merged. Depending on the item selected from the [List], the items that can be merged may 
vary.
 When selecting the [Material folder], the [Material information] inside the [Material folder] can be merged.
 When selecting the [Material panel folder], the [Materials] inside the [Material panel folder] can be merged.
 When selecting [Surface materials], only matching [Surface materials] can be merged. Only [Materials] in the same [Material panel 

folder] can be merged here.

(5) Duplicate node
Duplicates the [Material panel folder] selected from the [List].

(6) Delete node
Deletes the [Material panel folder] selected from the [List].

Command Bar
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Layout
Select [Layout] in [Group] to manage the layouts of 3D objects. [Layout] is used to set the position and display status of [Nodes] in a 3D object.

This section describes the functions of the [List] and [Command Bar]. For information on other functions, see "Functions in the Object Config-
uration Palette" .

List
(1) Layout folder

The folder where all [Layout] items are stored. Multiple [Layouts] can be saved and managed in a [Layout folder]. It is not possible to 
delete the [Layout folder] or change its name.

(2) Layout
Record the [Layouts] of 3D objects. One [Layout] is recorded for each item. Double click the name to rename the layout. The layout name 
input here is displayed in the settings screens in CLIP STUDIO PAINT.

Command Bar
(1) Add new

Click this to add a [Layout].

(2) Add from file
Cannot be used.

(3) Add from material
Cannot be used.

(4) Duplicate node
Duplicates the selected [Layout].

(5) Delete node
Deletes the [Layout] selected in the [List].

(6) Apply layout to object
Apply a [Layout] selected from the [List] to a 3D object in the [Document] window.

(7) Save object layout
Saves the allocation status of the 3D object in the [Document] window to the [Layout] selected in the [List].

Command Bar
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Angle
Select [Angle] in [Group] to manage the angles of 3D objects. [Angle] is used to set the camera angles for displaying 3D objects and configur-
ing multiple display settings of [Nodes] (parts).

This section describes the functions of the [List] and [Command Bar]. For information on other functions, see "Functions in the Object Config-
uration Palette" .

List
(1) Angle folder

The folder where all [Angle] items are stored. Multiple [Angles] can be saved and managed in the [Angle folder]. It is not possible to 
delete the [Angle folder] or change its name.

(2) Angle
Record the [Angles] of 3D objects. One [Angle] is recorded for each item. Double clicking the angle name allows you to enter an angle 
name. The angle name input here is displayed in the settings screens in CLIP STUDIO PAINT.

Command Bar
(1) Add new

Click this to add an [Angle].

(2) Add from file
Cannot be used.

(3) Add from material
Cannot be used.

(4) Duplicate node
Duplicates an [Angle] selected from the [List].

(5) Delete node
Deletes an [Angle] selected from the [List].

(6) Apply angle to object
Apply an [Angle] selected from the [List] to a 3D object in the [Document] window.

(7) Save object angle
Saves the camera angle and [Node] display status of the 3D object in the [Document] window to the [Angle] selected in the list.

Command Bar
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Movability
Select [Movability] in [Group] to manage the [Movability] of 3D objects parts. [Movability] is a function that records movement or rotation of 
the [Nodes] (parts) of 3D objects so that they can be operated using the sliders in CLIP STUDIO PAINT.

This section describes the functions of the [List] and [Command Bar]. For information on other functions, see "Functions in the Object Config-
uration Palette" .

List
(1) Movability folder

The folder where all [Movability] parts are stored. Multiple [Movability] parts can be saved and managed in the [Movability folder]. It is 
not possible to delete the [Angle folder] or change its name.

(2) Movability
Records the [Nodes] of 3D objects. Recording movement in [Movability] makes it possible to operate [Nodes] simply by dragging the 
sliders.

[Movability] can be operated using the sliders in the [Object information] palette in CLIP STUDIO MODELER.

Command Bar
(1) Add new

Click this to add a [Movability] part.

(2) Add from file
Cannot be used.

(3) Add from material
Cannot be used.

(4) Duplicate node
Duplicates a [Movability] part selected from the [List].

(5) Delete node
Deletes a [Movability] part selected from the [List].

Object configuration palette menu
This section describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the [Object 
configuration] palette.

Hide object configuration palette
Hides the [Object configuration] palette.

To display the [Object configuration] palette again, select [Window] menu → [Object configuration].

Command Bar
CLIP STUDIO MODELER USER GUIDE 59



Object Information Pal-
ette
The [Object information] palette is used to configure advanced settings for items selected on the [Object con-
figuration] palette.
This section describes the functions of the [Object configuration] palette.

 Functions of the Object Information Palette



Object Information Palette > Functions of the Object Information Palette > Standard display
Object Information Palette

 Functions of the Object Information Palette
This section describes the functions and names of each part of the [Object information] palette. The settings that can
be configured in the [Object information] palette vary depending on the item selected in the [List] of the [Object config-
uration] palette.

 "Standard display" 

 "When a sketch is selected" 

 "When a node is selected" 

 "When a material panel folder is selected" 

 "When a surface material in a surface material folder is selected" 

 "When a layout is selected" 

 "When an angle is selected" 

 "When a movability part is selected" 

Standard display
The following settings can be configured when no items are selected in the [Object configuration] palette.

(1) Thumbnail of 3D object material
A thumbnail of the 3D object material. This is displayed in CLIP STUDIO and the [Material] palette.

Click the thumbnail to display the [Capture thumbnail] window where a thumbnail can be captured for the part. For information on how to 
configure this, see "Capturing a Thumbnail" .

(2) Name
Displays the name of the edited material. Click this field to input a material name.

(3) Comment
A comment about the 3D object material can be set. Click this field to input a comment. Information such as a description of the material 
can be entered here.

This screen is displayed even when the selected item is locked or there are no items that can be configured indi-
vidually.
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(4) Size
The size of the 3D object can be specified in centimeters. Click this field to input a size.

The size of the 3D object is applied when the character is imported in CLIP STUDIO PAINT.

(5) Initial settings when importing materials
Set the state for loading 3D object materials into CLIP STUDIO PAINT.

(6) Apply current settings to new files
Clicking this saves the [Initial settings when importing materials] with the set contents. When creating another 3D object, the saved set-
tings will be applied.

The same ratio between width, depth and height is maintained when the size of the 3D object is changed.

Apply light source
When checked, the light source is enabled in CLIP STUDIO PAINT when loading the 3D object 
material.

Add outline
When checked, outlines are enabled in CLIP STUDIO PAINT when loading the 3D object mate-
rial.

Cast shadows on horizontal 
planes

When checked, shadows are enabled in CLIP STUDIO PAINT when loading the 3D object mate-
rial.

Set as pick target
When checked, this can be selected in CLIP STUDIO PAINT when loading the 3D object mate-
rial. When selection is enabled, specific parts can be selected on the canvas.

The contents set for [Initial settings when importing materials] can be changed inside CLIP STUDIO PAINT.
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When a sketch is selected
The following settings can be configured after selecting [Sketch image] in the [List] when [Sketch] is selected in the [Group] of the [Object 
configuration] palette.

(1) Import texture
Displays a preview of the sketch image selected in the [Object configuration] palette. Click this to display the dialog box for selecting a 
file. Import the image to be used as the [Sketch image]. This replaces the [Sketch image] being edited.

Image materials for textures can be imported as a [Sketch image] by dragging and dropping an image material from the [Material] palette 
to [Import texture].

(2) Sketch image name
Displays the name of the sketch image being edited. Double click this to input a sketch image name. When the sketch image name is 
changed, the sketch image name in the [Object configuration] palette also changes.

(3) Opacity
Allows you to configure the opacity of the [Sketch image].

(4) Edit texture in PAINT
Cannot be used.

(5) Export texture
Exports the sketch image displayed in [Import sketch image] in PNG format.

(6) Paste texture
Replaces the selected [Sketch image] with the image on the clipboard.

A [Sketch image] cannot be edited in the [Object information] palette when it is hidden.

File formats that can be imported BMP, JPG, PNG, TIFF, TGA
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When a node is selected
When a [Node] is selected from a [Group] in the [Object configuration] palette, the following items can be set.

(1) Displayed position
The [X coordinate], [Y coordinate] and [Z coordinate] can be set for the position of the [Node]. Enter a numeric value to move the [Node]. 
This is not applicable for the [Root node folder].

(2) Displayed rotation
Set the angle of a [Node] with [Rotate around x axis], [Rotate around y axis] and [Rotate around z axis]. Enter a numeric value to change 
the angle of the [Node] based on its origin. This is not applicable for the [Root node folder].

(3) Default position
The [X coordinate], [Y coordinate] and [Z coordinate] can be set for the position of the origin of the [Node]. Enter a numeric value to 
move the origin of the [Node]. This is not applicable for the [Root node folder].

(4) Initial rotation
[Rotate around x axis], [Rotate around y axis] and [Rotate around z axis] can be set for the angle of the origin of the [Node]. Enter a 
numeric value to change the angle of the origin of the [Node]. This is not applicable for the [Root node folder].
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(5) Adjust origin position
Clicking this displays the [Adjust origin position] dialog box. The origin position of the node can be adjusted by selecting it in the [Object 
configuration] palette.

Dialog box for Adjusting the Origin’s Position

(6)  Recalculate normals
Clicking these displays the [Recalculate normals] dialog box. This recalculates the normals for the nodes selected in the [Object configu-
ration] palette.

Recalculate normals dialog box

(1) Target node Displays the name of the [Nodes] for adjusting the position of origin.

(2) Apply to Child node(s) When checked, the origin is adjusted for all nodes included in the [Node] folder.

(3) Reset target axis

Resets the default axis for the origin’s position. Select [Center], [x axis], [y axis] or [ z axis]. 
When [Center] is selected, the node’s origin is reset to its center. When either the [x axis], [y 
axis], or [z axis] are selected, the selected axis is reset to face forward. The origin’s value can 
be confirmed via [Default center] in the [Object information] palette.

(4) Reset to reversed orientation 

This can be set when [x axis], [y axis] or [z axis] are selected as [Standard direction].

When checked, the origin’s position is reset to the opposite direction of the direction selected 
for [Reset target axis]. The origin’s value can be confirmed via [Default center] in the [Object 
information] palette.

(1) Target node Displays the name of the [Nodes] for adjusting the position of origin.

(2) Apply to Child node(s) When checked, the normals are recalculated for all nodes included in the [Nodes] folder. 

(3) Smooth angle
If the angle between the faces is larger than the angle set here, the normals are calculated to 
not be continuous.

For information on how to display normals, see "Document Window" .
CLIP STUDIO MODELER USER GUIDE 65



Object Information Palette > Functions of the Object Information Palette > When a material panel folder is selected
When a material panel folder is selected
The following settings can be configured in the [Object information] palette after selecting a [Material panel folder] in the [List] when [Mate-
rial] is selected in the [Group] of the [Object configuration] palette.

(1) Thumbnail
The thumbnail of the [Material panel folder].

Click the thumbnail to display the [Capture thumbnail] window where a thumbnail can be captured for the [Material]. For information on 
how to configure this, see "Capturing a Thumbnail" .

(2) Name
Displays the name of the material being edited. Click this field to input the material name. The input name is applied to the [Object config-
uration] palette.

This material name is displayed in the screen for configuring 3D object material settings in CLIP STUDIO PAINT.

(3) Comment
A comment about the [Material panel folder] can be set. Click this field to input a comment. Information such as a description of the 
[Material panel folder] can be entered here.

(4) Set to default material
In case of 3D objects with more than one [Material panel folder], [Material panel folders] selected in the [Object configuration] palette can 
be set as default [Materials].

When loading 3D object materials into CLIP STUDIO PAINT, the set [Material] is applied.

A [Material panel folder] cannot be edited in the [Object information] palette when it is hidden.
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When a surface material in a surface material folder is selected
The following settings can be configured in the [Object information] palette after selecting a [Surface material] in a [Surface material folder] 
when [Material] is selected in the [Group] of the [Object configuration] palette.

(1) Import texture
When a texture image is linked to the [Surface material] selected in the [Object configuration] palette, a preview of the texture image is 
displayed. Click this to display the dialog box for selecting a file. Import the image file to be set as the texture and replace the texture 
image.

(2) Name
Displays the name of the selected surface material. Double clicking the field allows you to enter a surface material name. The input name 
is applied to the [Object configuration] palette.

(3) Diffused light
The RGB value for the [Diffused light] of the [Surface material] can be adjusted.

[Diffused light] is light that creates an even (diffused) reflection when the light source illuminates a [Surface material].

(4) Specular light
The RGB value for the [Specular light] of the [Surface material] can be adjusted.

(5) Ambient light
The RGB value for the [Ambient light] of the [Surface material] can be adjusted.

[Ambient light] is light that illuminates the 3D object evenly from all directions.

(6) Emitted light
The RGB value for the [Emitted light] of the [Surface material] can be adjusted.

(7) Luminosity
The luminosity of the [Surface material] can be set.

(8) Opacity
The opacity of the [Surface material] can be changed.

File formats that can be imported BMP, JPG, PNG, TIFF, TGA

[Diffused light] cannot be set when a texture image is linked to the [Surface material]. If a texture image is linked, 
the [Texture image] is displayed in the [Object information] palette.
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(9) Edit in PAINT
If CLIP STUDIO PAINT is installed on your computer or device, the texture linked to the [Surface material] can be edited in CLIP STU-
DIO PAINT.

For details, see "Editing Textures in CLIP STUDIO PAINT" .

(10)Export texture
The texture linked to the [Surface material] can be exported as an image in PNG format.

(11) Paste texture
Replaces the texture linked to the [Surface material] with the image on the clipboard.

When a layout is selected
The following settings can be configured in the [Object information] palette after selecting a [Layout] in a [Layout folder] when [Layout] is 
selected in the [Group] of the [Object configuration] palette.

(1) Thumbnail
The thumbnail of the [Layout]. Click the thumbnail to display the [Capture thumbnail] window where a thumbnail can be captured for the 
[Layout]. For information on how to configure this, see "Capturing a Thumbnail" .

(2) Name
Displays the name of the [Layout] being edited. Click this to rename the [Layout]. The input name is applied to the [Object configuration] 
palette.

The [Layout] name is displayed in the screen for configuring 3D object material settings in CLIP STUDIO PAINT.

(3) Comment
A comment about the [Layout] can be set. Click this field to input a comment. Information such as a description of the [Layout] can be 
entered here.

[Edit in PAINT] cannot be set when a texture image is linked to the [Surface material].

[Export texture] cannot be set when a texture image is linked to the [Surface material].

[Paste texture] cannot be set when a texture image is linked to the [Surface material].
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(4) Set display state of node
Click this to display a list of nodes. Set the [Nodes] to be displayed in the [Layout] using the [Visible/Invisible] icons.

(5) Apply layout to object
Apply a [Layout] selected from the [Object configuration] palette to a 3D object in the [Document] window.

(6) Save object layout
Saves the [Node] allocation status of the 3D object in the [Document] window to the [Layout] selected in the [Object configuration] pal-
ette.

(7) Set to default layout
In case of 3D objects with more than one [Layout], [Layouts] selected in the [Object configuration] palette can be set as default [Layouts].

When loading 3D object materials into CLIP STUDIO PAINT, the set [Angle] is applied.

 If the item you want to set is not displayed when [Set display state of node] is opened, check the [List] in the 
[Node] group of the [Object configuration] palette.

 When a [Node] folder is closed in the [List], [Nodes] below that folder are not displayed in [Set display state of 
node]. Make sure that the folder containing the [Node] to be configured is open and displayed in the [List].
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When an angle is selected
The following settings can be configured in the [Object information] palette after selecting an [Angle] in an [Angle folder] when [Angle] is 
selected in the [Group] of the [Object configuration] palette.

(1) Thumbnail
The thumbnail of the [Angle]. Click the thumbnail to display the [Capture thumbnail] window where a thumbnail can be captured for the 
angle. For information on how to configure this, see "Capturing a Thumbnail" .

(2) Name
Displays the name of the [Angle] being edited. Click this field to input an [Angle] name. The input name is applied to the [Object config-
uration] palette.

This angle name is displayed in the screen for configuring 3D object material settings in CLIP STUDIO PAINT.

(3) Comment
A comment about the [Angle] can be set. Click this field to input a comment. Information such as a description of the [Angle] can be 
entered here.
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(4) Set display state of node
Click this to display a list of nodes. Set the [Nodes] to be displayed in the [Angle] using the [Visible/Invisible] icons.

(5) Apply angle
Apply an [Angle] selected from the [Object configuration] palette to an object in the [Document] window.

(6) Save angle
Saves the angle of the object in the [Document] window to the [Angle] selected in the [Object configuration] palette.

(7)  Reset to default angle
In case of 3D objects with more than one [Angle], [Angles] selected in the [Object configuration] palette can be set as default [Angles].

When loading 3D object materials into CLIP STUDIO PAINT, the set [Angle] is applied.

 If the item you want to set is not displayed when [Set display state of node] is opened, check the [List] in the 
[Node] group of the [Object configuration] palette.

 When a [Node] folder is closed in the [List], [Nodes] below that folder are not displayed in [Set display state of 
node]. Make sure that the folder containing the [Node] to be configured is open and displayed in the [List].
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When a movability part is selected
The following settings can be configured in the [Object information] palette after selecting a [Movability] part in a [Movability folder] when 
[Movability] is selected in the [Group] of the [Object configuration] palette.

(1) Thumbnail
The thumbnail of the part with [Movability]. Click the thumbnail to display the [Capture thumbnail] window where a thumbnail can be 
captured for the part with [Movability]. For information on how to configure this, see "Capturing a Thumbnail" .

(2) Name
Displays the name of the [Movability] part being edited. Click this field to input a name for the part with [Movability]. The input name is 
applied to the [Object configuration] palette.

This name is displayed in the screen for configuring 3D object material settings in CLIP STUDIO PAINT.

(3) Comment
A comment about the [Movability] part can be set. Click this field to input a comment. Information such as a description of the [Movabil-
ity] part can be entered here.

(4)  Movable node
Displays the name of the [Nodes] for setting [Movability] parts.

(5) Position
Set the [X coordinate], [Y coordinate] and [Z coordinate] of the [Node]. The position of [Nodes] can be adjusted by inputting numeric val-
ues. When selecting the [Move parts] sub tool, the position of the [Nodes] in the [Document Window] can be adjusted directly. For details, 
see "Move parts" .

(6) rotation
Set [Rotate around x axis], [Rotate around y axis] and [Rotate around z axis] for the [Node]. Enter a numeric value to adjust the angle of 
the [Node] based on its origin or rotation center.

The rotation center of a [Node] is displayed by selecting the [Move parts] sub tool. The position for the controller of the manipulator is the 
center of rotation. The [Move parts] sub tool can also be used to adjust the angle of [Nodes]. For details, see "Move parts" .

(7) Rotation center
Set the rotation center of a node by entering an [X coordinate], [Y coordinate] and [Z coordinate]. The rotation center of a [Node] is dis-
played by selecting the [Move parts] sub tool. The position for the controller of the manipulator is the center of rotation.

To select the node for which to set [Movability], select a [Node] from [Target node] and confirm with [Turn this 
node into a movable node].
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(8) Use the node origin as the center of rotation
When checked the node origin is used as the center of rotation.

(9) Key frame
A slider for recording the movement of the [Node]. The left end of the slider records the initial status of the [Node] and the right end 
records the maximum movement of the [Node]. A [Key frame] is displayed below the slider in areas where a movement is recorded. [Key 
frame] positions can also be recorded by inputting values between 0 and 40.

Drag the slider to play the movement of [Nodes] recorded with [Movability].

(10)Add key frame
Record the [Node] movement on the slider. A [Key frame] is created in the recorded position. Key frames can also be added between slid-
ers.

(11) Delete key frame
Deletes a [Key frame] added to the slider. Move the slider to the position where the [Key frame] is located before deleting the [Key frame].

(12)Target node
Select a [Node] (part) to be made into a movability part from the pull down menu. Movability parts cannot be set only through selection. 
Click [Turn this node into a movable node] to confirm.

(13)Turn this node into a movable node
Confirm the [Node] selected via [Target Node] as the [Node] to set movability for. Once confirmed, the [Node] selected via [Target node] 
is displayed under [Movable node].

Object information palette menu
This section describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the [Object 
information] palette.

Hide object information palette
Hides the [Object information] palette.

 When [Use the node origin as the center of rotation] is turned off, and the [Move part origin point] sub tool is 
selected, use the manipulator to move the rotation center of the [Node]. For information on the [Move part ori-
gin point] tool, see "Move part origin point" .

 When [Use the node origin as the center of rotation] is turned on, the [Rotation center] cannot be set.

 When selecting the [Move part origin point] sub tool, use the manipulator to move the origin of the [Node]. For 
information on the [Move part origin point] tool, see "Move part origin point" .

 When [Use the Position origin as the center of rotation] is turned off, and the [Move part origin point] sub tool 
is selected, the manipulator to move the origin position of the [Node] is displayed.

To display the [Object information] palette again, select [Window] menu → [Object information].
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3D Character Setup 
Screen
This section describes the following items in the 3D Character Setup screen. 

 Configuration of the 3D Character Setup Screen

 Functions in the 3D Character Setup Screen

 Tool List (3D Character Setup Screen)

 Character Configuration Palette

 Character Information Palette

 Default Bone Mapping Mode

 Standard Bone Creation Mode

 Skirt Settings Mode



Configuration of the 3D 
Character Setup Screen
The 3D Character Setup screen in CLIP STUDIO MODELER is displayed by selecting [3D character] in the 
[New] dialog box. This section describes the configuration of the 3D Character Setup screen.

 About the 3D Character Setup Screen
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Configuration of the 3D Character Setup Screen

 About the 3D Character Setup Screen
The 3D Character Setup screen is displayed by selecting [3D character] in the [New] dialog box.

In this screen, you can load 3D data and set up a 3D character that can be used in CLIP STUDIO PAINT. You can load
multiple 3D data items, such as a body, hairstyle and facial expression, and combine them to customize your 3D char-
acter. You can also set bones compatible with CLIP STUDIO PAINT for your 3D data, so that your character can be
freely posed.

The 3D Character Setup screen in CLIP STUDIO MODELER consists of the following main components.
o

(1) Command Bar
Allows you to use various functions by clicking the icons. For information on each item in the [Command Bar], see "Command Bar" .

(2) Palette Dock
Area accommodating multiple palettes.
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(3) Palette
Screen for configuring settings. There are various types of palettes. In this screen, palettes are accommodated in palette docks. However, 
they can also be displayed individually as windows or dialog boxes.

For information on palettes that can be used in the character setup screen, see "Palettes in the Character Setup Screen" .

(4) Document Window
Area for displaying and performing operations for models being created. For information on each item in the [Document] window, see 
"Document Window" .

Command Bar
The area on the upper part of the main window where function icons are arranged is called "Command Bar". Clicking an icon on the [Com-
mand Bar] is equivalent to executing a menu function.

(1) Start CLIP STUDIO
Start CLIP STUDIO. CLIP STUDIO is a tool for supporting creative activities.

(2) New
The [New] dialog box is displayed. You can select the type of work and create a new work.

(3) Open
Opens a saved file, etc. for re-editing.

(4) Save
Saves the edited file newly or under the same name.

(5) Undo
Clicking it cancels the last operation.

(6) Redo
Clicking it redoes the undone operation.

(7) Reset camera
Returns the viewpoint of the camera to its initial status.

(8) CLIP STUDIO MODELER Support
The web browser is launched and the CLIP STUDIO MODELER Support site is displayed.
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Document Window
The [Document] window is an area for displaying and performing operations for models being created.

(1) Tabs for switching between documents
Displays the file names of the models being edited. Clicking the tabs allows you to switch the file or view to edit.

(2) Show / Hide point
Displays/hides the highest point of the 3D character.

Select the [Window] menu → [Document] to switch to the [Document] window. For details, see "Menu" →"Window 
Menu" →"Document" .
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(3) Show / Hide edge
Displays/hides the edge of the 3D character.

(4) Show / Hide normals
Cannot be used.

(5) Show / Hide bone
Displays/hides the bones of the 3D character.

ｍｐmp
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(6) Show / Hide physics object
Displays/hides the physics object for 3D characters where a physics object is set.

(7) Enable / Disable physics operation
If physics operations are enabled for 3D characters where skirt settings or physics operations are set, the settings are applied when the 3D 
character is dragged.

(8) Document
The area for editing 3D characters.

(9) World coordinate axes
The baseline coordinate axes of the 3D space. There are three axes: the X axis (red), the Y axis (green) and the Z axis (blue).

The skirt transforms 
according to 
the shape of the legs.
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Palettes in the Character Setup Screen
The following palettes are displayed in the character setup screen.

Tool Palette
Various tools are arranged as buttons. Clicking a button enables the tool for use.

For details on the [Tool] palette, see "Tool Palette" .

Sub tool palette
Each tool comes with preconfigured settings called [Sub tool]. Select a sub tool in accordance with the 
purpose of the tool to use.

For details on the [Sub tool] palette, see "Sub Tool Palette" .

Tool property Palette
Allows you to adjust the settings of the sub tool selected on the [Sub Tool] palette.

For details on the [Tool Property] palette, see "Tool Property Palette" .

Character Configuration 
Palette

The [Character configuration] palette is used to manage multiple body, face and hair parts in a folder.

For details on the [Character configuration] palette, see "Character Configuration Palette" .

Character Information Pal-
ette

The [Character information] palette is used to configure advanced settings for items selected on the 
[Character configuration] palette.

For details on the [Character information] palette, see "Character Information Palette" .

Navigator Palette

The [Navigator] palette is used to adjust the camera angle by dragging the rectangle on the palette. 
You can also change the camera distance and switch the projection method and perspective using the 
icons and sliders on the palette.

For details on the [Navigator] palette, see "Navigator Palette" .

Camera Settings Palette
The [Camera settings] palette is used to change the camera angle and distance and switch the projec-
tion method and perspective.

For details on the [Camera settings] palette, see "Camera Settings Palette" .

View Settings Palette
The [View Settings] palette is used to configure grid count and screen view settings such as [Drawing 
effects] and the [Shader]. For details on the [View Settings] palette, see "View Settings Palette" .

Material Palettes
The [Material] palette is used to manage various materials in the CLIP STUDIO series. For details on 
the [Material] palette, see "Material Palette" .
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Functions in the 3D Char-
acter Setup Screen
This section explains how to use the 3D Character Setup Screen to set up 3D characters that can be used in 
CLIP STUDIO PAINT.

 Importing 3D Materials

 Editing and Setting Texture

 Creating and Registering Poses

 Setting 3D Character Information

 Mapping Default Bones to Different Bones

 Adding Default Bones to a Model with No Bones

 Setting Natural Movement for Skirts
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Functions in the 3D Character Setup Screen

 Importing 3D Materials
This section explains how to import 3D files in the character setup screen.

Full-body Character Data
This section explains how to import a complete character file including body, face and hair.

The following file formats can be imported.

1 Select the file to be imported
Files are imported in the [Character configuration] palette.

(1) Select [Body] from the group on the [Character configuration] palette.

(2) Click [Add from file].

(3) When the dialog box for opening a file is displayed, select the file to be imported and click [Open].

2 The file is imported
The selected file is imported in CLIP STUDIO MODELER.

(1) A [Body parts folder] is displayed for the imported file under [Body].

(2) The imported body is displayed in the [Document] window.

File formats that can be imported CLIP STUDIO MODELER file format (extension: csmf), fbx, 6kt, 6kh, lwo, obj

If you are creating a 3D model using Autodesk Maya, you can set default bones at this time for greater conve-
nience.
Default bones are the bones set for movable models. Setting default bones makes it possible to create 3D charac-
ters that will operate correctly with CLIP STUDIO products. For information on the specifications of default bones, 
see "Specifications of Default Bones (Guide to Creating Movable Models)".
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3 Set the character as a complete character
Set the character you have imported as a complete character.

(1) Select the [Body parts folder] for the imported file on the [Character configuration] palette.

(2) Turn on [Use as complete character] in the [Character information] palette.

Body
This section explains how to import body files.

The following file formats can be imported.

1 Select the file to be imported
Files are imported in the [Character configuration] palette.

(1) Select [Body] from the group on the [Character configuration] palette.

(2) Click [Add from file].

When a character is set as a full character, duplicate parts such as [Face] and [Hair] can be hidden.

File formats that can be imported CLIP STUDIO MODELER file format (extension: csmf), fbx, 6kt, 6kh, lwo, obj

If you are creating a 3D model using Autodesk Maya, you can set default bones at this time for greater conve-
nience.
Setting default bones makes it possible to create 3D characters that will operate correctly with CLIP STUDIO prod-
ucts. For information on the specifications of default bones, see "Specifications of Default Bones (Guide to Creat-
ing Movable Models)".
If default bones cannot be added, they can be assigned in "Default Bone Mapping Mode"  or "Standard Bone Cre-
ation Mode" .
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(3) When the dialog box for opening a file is displayed, select the file to be imported and click [Open].

2 The file is imported
The selected file is imported in CLIP STUDIO MODELER.

(1) A [Body parts folder] is displayed for the imported file under [Body].

(2) The imported body is displayed in the [Document] window.

Face
This section explains how to import face files.

The following file formats can be imported.

1 Select the file to be imported
Files are imported in the [Character configuration] palette.

(1) Select [Face] from the group on the [Character configuration] palette.

(2) Click [Add from file].

(3) When the dialog box for opening a file is displayed, select the file to be imported and click [Open].

File formats that can be imported fbx

Default bones need to be set for 3D files for faces. For information on the specifications of default bones, see 
"Specifications of Default Bones (Guide to Creating Movable Models)".
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2 The file is imported
The selected file is imported in CLIP STUDIO MODELER.

(1) A [Face parts folder] is displayed for the imported file under [Face].

(2) The imported face is displayed in the [Document] window.

Hair
This section explains how to import hair files.

The following file formats can be imported.

1 Select the file to be imported
Files are imported in the [Character configuration] palette.

(1) Select [Hair] from the group on the [Character configuration] palette.

(2) Click [Add from file].

(3) When the dialog box for opening a file is displayed, select the file to be imported and click [Open].

To adjust the position and size of face parts, select the [Face parts folder] to be adjusted in the [Character config-
uration] palette and set [Origin], [Orientation] and [Scale] in the [Character information] palette. For details, see 
"When a part is selected" →"Face parts folders" .
The position of hair parts can also be adjusted using the [Move parts] sub tool. For details, see "Move parts" .

File formats that can be imported fbx

Default bones need to be set for 3D files for hair. For information on the specifications of default bones, 
see"Specifications of Default Bones (Guide to Creating Movable Models)".
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2 The file is imported
The selected file is imported in CLIP STUDIO MODELER.

(1) A [Hair parts folder] is displayed for the imported file under [Hair].

(2) The imported hair is displayed in the [Document] window.

Accessories
This section explains how to import accessory files.

The following file formats can be imported.

1 Select the file to be imported
Files are imported in the [Character configuration] palette.

(1) Select [Accessories] from the group on the [Character configuration] palette.

(2) Click [Add from file].

(3) When the dialog box for opening a file is displayed, select the file to be imported and click [Open].

To adjust the position and size of hair parts, select the [Hair parts folder] to be adjusted in the [Character configu-
ration] palette and set [Origin], [Orientation] and [Scale] in the [Character information] palette. For details, see 
"When a part is selected" →"Hair parts folders" .
The position of hair parts can also be adjusted using the [Move parts] sub tool. For details, see "Move parts" .

File formats that can be imported fbx
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2 The file is imported
The selected file is imported in CLIP STUDIO MODELER.

(1) An [Accessory parts folder] is displayed for the imported file under [Accessories].

(2) The imported accessory is displayed in the [Document] window.

3 Adjust the position and size of the accessory
Adjust the position and size of the accessory relative to the character.

(1) Select the [Accessory parts folder] from the group on the [Character configuration] palette.

(2) Select the bone where you want to attach the accessory from [Attachment destination] in the group on the [Character information] 
palette.

(3) Adjust the [Origin] and [Orientation] values in the [Character information] palette to change the position and angle of the accessory.

(4) Adjust [Scale] in the [Character information] palette to change the size of the accessory.

The position of accessory parts can also be adjusted using the [Move parts] sub tool. For details, see "Move 
parts" .
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Displaying Parts
Multiple parts can be assigned by using the [Body], [Face], [Hair] and [Accessories] groups on the [Character configuration] palette.

This section explains how to switch the parts displayed in the [Document] window.

Click [Visible/Invisible] for the part to be displayed in the [Character configuration] palette.

Parts set as [Visible] are displayed.

Only one [Body], [Face] and [Hair] part can be displayed in the [Document] window.
Multiple [Accessories] parts can be displayed at once.

It is not possible to edit items in parts folders by clicking [Visible/Invisible] to display them in the [Document] win-
dow.
Parts folders can be selected and their contents can be edited by meeting the following conditions.

 Display the part in the [Document] window.

 Click to select the following items in the parts folder displayed in the [Character configuration] palette.

Visibility status

Parts set as [Visible] are displayed.
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 Editing and Setting Texture
The texture of a 3D character can be edited to change the color of their clothing or their facial expression.

Adding a Parts Folder
Before editing a [Surface material], duplicate the [Parts folder] (add a new one). Duplicating the folder means that the original [Surface mate-
rial] can be restored later after editing the [Surface material].

1 Select a parts folder
Select the [Parts folder] from the [List] on the [Character configuration] palette.

2 Duplicate the parts folder
Duplicate the selected [Parts folder].

(1) Click [Duplicate node].

(2) The [Parts folder] is duplicated in the [List].
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Exporting Textures
Textures can be exported as images in PNG format. Exported texture images can be edited in image editing software.

[Surface material] items in [Surface material information] and [Texture] items in [Additional texture] can be exported as textures.

1 Select a texture
Select the texture to be exported from the [Character configuration] palette.

(1) Display the [Parts folder] containing the texture to be exported in the [List].

(2) Select the texture to be changed.

2 Exporting Textures
Click [Export texture] in the [Character information] palette.

When the [Save As] dialog box is displayed, specify a location and save the texture.

The exported file can be imported into CLIP STUDIO MODELER after editing with image editing software.
For information on importing, see "Changing Textures" .
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Changing Textures
You can change textures to a different image format. [Surface material] items in [Surface material information] and [Texture] items in [Addi-
tional texture] can be changed in this way.

The following file formats are supported.

1 Select a texture
Select the texture to be changed from the [Character configuration] palette.

(1) Display the [Parts folder] containing the texture to be exported in the [List].

(2) Select the texture to be changed.

2 Import a texture
You can import a new texture for the selected texture.

(1) Click [Import texture] in the [Character information] palette. When the dialog box for selecting a file is displayed, select the image 
file to be used for the texture.

File formats that can be imported BMP, JPG, PNG, TIFF, TGA

If you want to keep the original [Surface material], select the [Parts folder] in the [Character configuration] palette 
and click [Duplicate node].
The [Parts folder] containing the original [Surface material] is duplicated.
CLIP STUDIO MODELER USER GUIDE 92



Functions in the 3D Character Setup Screen > Editing and Setting Texture > Editing Textures in CLIP STUDIO PAINT
(2) The texture changes and the new texture is applied to [Import texture] in the [Character information] palette.

(3) The new texture is applied to the 3D character in the [Document] window.

Editing Textures in CLIP STUDIO PAINT
If both CLIP STUDIO PAINT and CLIP STUDIO MODELER are installed on your computer, you can start CLIP STUDIO PAINT and edit 
textures there.

[Surface material] items in [Surface material information] and [Texture] items in [Additional texture] can be edited in this way.

1 Select a texture
Select the texture to be edited from the [Character configuration] palette.

(1) Display the [Parts folder] containing the texture to be exported in the [List].

(2) Select the texture to be changed.

You can also import a texture by copying the image for the desired texture to the clipboard in software such as a 
graphics program, then clicking [Paste texture] in the [Character information] palette.

If you want to keep the original texture, select the [Parts folder] in the [Character configuration] palette and click 
[Duplicate node].
The [Parts folder] containing the original texture is duplicated.
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2 Start CLIP STUDIO PAINT
Click [Edit in PAINT] in the [Character information] palette.

3 Edit in CLIP STUDIO PAINT
CLIP STUDIO PAINT opens in synchronized edit mode and the texture is displayed on the canvas.

The [Editing texture] window is also displayed.

When you edit a texture in CLIP STUDIO PAINT, the edits are automatically applied in the [Editing texture] window.

4 Exit the editing screen
Exit CLIP STUDIO PAINT or close the window of the texture being edited in CLIP STUDIO PAINT. CLIP STUDIO MODELER returns 
to the normal view.

 For instructions on using CLIP STUDIO PAINT, see “CLIP STUDIO PAINT User Guide”.

 If the edits are not applied in CLIP STUDIO PAINT, turn on [Enable Auto Save] in the [File] menu of CLIP STU-
DIO PAINT.

 You can also edit it using multiple layers in CLIP STUDIO PAINT, then save it with the layers integrated.

The edited item can be checked 

in the [Editing texture] window 

of CLIP STUDIO MODELER.

Edit the texture 

in CLIP STUDIO PAINT.
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Editing Facial Expressions
Facial expression textures for 3D characters can be exported from CLIP STUDIO MODELER and edited in image editing software that sup-
ports Photoshop documents (extension: psd).

Edited facial expression textures can be imported to CLIP STUDIO MODELER.

First, prepare the facial expression texture so that it can be used in the [Face parts folder]. Select a [Face parts folder] from the [Face] group on 
the [Character configuration] palette.

Turning on [Use facial expression texture] in the [Character information] palette enables facial expression textures to be exported and 
imported.
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Exporting Facial Expression Textures
Facial expression textures are exported as Photoshop document files (extension: psd). The exported Photoshop document files can be imported 
into image editing software to edit the texture.

1 Select the part
Select a [Face parts folder] in the [Facial expression] group on the [Character configuration] palette to export the facial expression texture.

(1) Display the [Face parts folder] containing the texture to be exported in the [List].

(2) Click the name of the [Face parts folder] where you want to export the facial expression texture.

2 Export the facial expression texture
Click [Export facial expression] in the [Character configuration] palette. When the dialog box for saving is displayed, specify the location 
and file name to export the facial expression texture as a Photoshop document file (extension: psd).

 Facial expression textures can also be exported by clicking [Export facial expression] in the [Character infor-
mation] palette.

 All facial expression textures belonging to the selected part are exported. It is not possible to export a specific 
facial expression texture on its own.

 Exported facial expression textures can be edited in image editing software such as CLIP STUDIO PAINT. For 
information on the specifications of facial expression textures, see "Specifications of Facial Expression Tex-
tures" .
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Importing Facial Expression Textures
Import facial expression textures in the [Character configuration] palette.

1 Select the part
Select a [Face parts folder] in the [Facial expression] group on the [Character configuration] palette to import the facial expression texture.

(1) Display the [Face parts folder] containing the texture to be imported in the [List].

(2) Click the name of the [Face parts folder] where you want to import the facial expression texture.

2 Import the facial expression texture
Click [Import facial expression] in the [Character configuration] palette. When the dialog box for selecting a file is displayed, select the 
Photoshop document file to be used for the facial expression texture.

If a facial expression texture with the same name already exists in the [Face parts folder] where you have 
imported the facial expression texture, it is overwritten with the imported texture. It is recommended that you 
back up any textures that you want to keep before importing a new texture. Facial expression textures can be 
backed up by exporting the texture or duplicating the part.

For information on the specifications of facial expression textures, see "Specifications of Facial Expression Tex-
tures" .

Facial expression textures can also be imported by clicking [Import facial expression] in the [Character informa-
tion] palette.
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3 Check the facial expression texture
The edited facial expression texture is applied to the [Face parts folder]→[Facial expression] in the [Character configuration] palette.

If the number of facial expressions has not changed, click the [Visible/Invisible] icon for facial expression textures to display the facial 
expression in the [Document] window.

For information on how to capture thumbnails of facial expressions, see "Capturing a Thumbnail" →"Facial 
Expressions for Characters" .
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Specifications of Facial Expression Textures
This section explains the specifications of facial expression textures for reference when editing exported facial expression textures in image 
editing software.

Facial expression textures are created from the layer configuration shown below.

 When face parts are imported, the facial expression texture linked to the 3D model is copied to the base folder 
for each facial expression layer.

 Facial expressions can be added in image editing software. A new layer folder is created when a facial expres-
sion is added. The configuration in the layer folder is the same as existing layer folders such as [exp_default_] 
and [exp_smile_].

The edited item can be checked in 
the [Editing texture] window 
of CLIP STUDIO MODELER.
[Character configuration] palette

[Character configuration] palette:

[Facial expression]

[Character information] palette:

[Eyes]

[Character information] palette:

[Mouth]

The edited item can be checked in 
the [Editing texture] window 
of CLIP STUDIO MODELER.
[Character information] palette
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Layer name Display and role in the palette

exp_default_
The layer folder used to manage the [Default] facial expression 
on the [Character configuration] palette.

eyes
The layer folder used to manage the [Eyes] facial expression 
on the [Character information] palette.

eye_right The [Right] setting for [Eyes]

eye_left The [Left] setting for [Eyes]

eye_down The [Down] setting for [Eyes]

eye_up The [Up] setting for [Eyes]

eye_close The [Close] setting for [Eyes]

eye_open The [Open] setting for [Eyes]

mouths
The layer folder used to manage the [Mouth] facial expression 
on the [Character information] palette.

mouth_o The [O] setting for [Mouth]

mouth_e The [E] setting for [Mouth]

mouth_u The [U] setting for [Mouth]

mouth_i The [I] setting for [Mouth]

mouth_a The [A] setting for [Mouth]

mouth_close The [Close] setting for [Mouth]

base The base for the [Default] facial expression.

exp_smile_
The layer folder used to manage the [Smile] facial expression 
on the [Character configuration] palette.

eyes
The layer folder used to manage the [Eyes] facial expression 
on the [Character information] palette.

eye_right The [Right] setting for [Eyes]

eye_left The [Left] setting for [Eyes]

eye_down The [Down] setting for [Eyes]

eye_up The [Up] setting for [Eyes]

eye_close The [Close] setting for [Eyes]

eye_open The [Open] setting for [Eyes]

mouths
The layer folder used to manage the [Mouth] facial expression 
on the [Character information] palette.

mouth_o The [O] setting for [Mouth]

mouth_e The [E] setting for [Mouth]

mouth_u The [U] setting for [Mouth]

mouth_i The [I] setting for [Mouth]
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mouth_a The [A] setting for [Mouth]

mouth_close The [Close] setting for [Mouth]

base The base for the [Smile] facial expression.

exp_anger_
The layer folder used to manage the [Anger] facial expression 
on the [Character configuration] palette.

eyes
The layer folder used to manage the [Eyes] facial expression 
on the [Character information] palette.

eye_right The [Right] setting for [Eyes]

eye_left The [Left] setting for [Eyes]

eye_down The [Down] setting for [Eyes]

eye_up The [Up] setting for [Eyes]

eye_close The [Close] setting for [Eyes]

eye_open The [Open] setting for [Eyes]

mouths
The layer folder used to manage the [Mouth] facial expression 
on the [Character information] palette.

mouth_o The [O] setting for [Mouth]

mouth_e The [E] setting for [Mouth]

mouth_u The [U] setting for [Mouth]

mouth_i The [I] setting for [Mouth]

mouth_a The [A] setting for [Mouth]

mouth_close The [Close] setting for [Mouth]

base The base for the [Anger] facial expression.

exp_sad_
The layer folder used to manage the [Sad] facial expression on 
the [Character configuration] palette.

eyes
The layer folder used to manage the [Eyes] facial expression 
on the [Character information] palette.

eye_right The [Right] setting for [Eyes]

eye_left The [Left] setting for [Eyes]

eye_down The [Down] setting for [Eyes]

eye_up The [Up] setting for [Eyes]

eye_close The [Close] setting for [Eyes]

eye_open The [Open] setting for [Eyes]

mouths
The layer folder used to manage the [Mouth] facial expression 
on the [Character information] palette.

mouth_o The [O] setting for [Mouth]

Layer name Display and role in the palette
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mouth_e The [E] setting for [Mouth]

mouth_u The [U] setting for [Mouth]

mouth_i The [I] setting for [Mouth]

mouth_a The [A] setting for [Mouth]

mouth_close The [Close] setting for [Mouth]

base The base for the [Sad] facial expression.

Layer name Display and role in the palette
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 Creating and Registering Poses
3D characters can be posed and the poses can be registered. The set poses cannot be used in CLIP STUDIO PAINT.

Importing a Pose
Pose materials registered to a 3D character in the [Material] palette can be imported.

1 Select the tool
Select the [Move] tool from the [Tool] palette and select [Bone operation] from the [Sub Tool] palette.

2 Import the pose
Pose materials are imported in the [Character configuration] palette.

(1) Click [Add from material].

(2) Select a pose material from the [Pose data] dialog box.

(3) Click [OK].
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(4) The [Pose] is added.

Creating a Pose
Simple poses can be added to 3D characters by using the [Bone operation] sub tool in CLIP STUDIO MODELER.

Select the [Move] tool from the [Tool] palette and select [Bone operation] from the [Sub Tool] palette.

Moving parts
Drag the part of the 3D character to be moved. This moves the part.

 For information on applying the added [Pose], see "Applying a Pose" .

 Click [Add from file] on the [Character configuration] palette to add a POSE STUDIO pose file (extension: pep).

Drag
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Rotating parts
Click to select the part of the 3D character to be rotated and move the mouse wheel. The selected part rotates.

Using manipulators
Manipulators are displayed when you click to select the part of the 3D character to be rotated.

Drag the ring of the [Red], [Blue] or [Green] manipulator with the mouse cursor. The part bends in the direction of the manipulator ring.

For information on manipulators, see "Bone operation" .

Operate the wheel 

to rotate the part.

Drag along the ring.
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Registering a Pose
Poses displayed in the [Document] window can be registered to the [Character configuration] palette. 

1 Select the tool
Select the [Move] tool from the [Tool] palette and select [Bone operation] from the [Sub Tool] palette.

2 Add a new pose
Create a [Pose] in the [Character configuration] palette.

(1) Click [Add new].

(2) The [Pose] is added.

3 Pose a 3D character
Pose a 3D character in the [Document] window. For information on how to pose a character, see "Creating a Pose" .
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4 Registering a Pose
Register the pose in the [Document] window to the newly added [Pose].

(1) Select the newly added [Pose].

(2) Click [Save character pose].

 To check whether a [Pose] is registered, see "Applying a Pose" .

 To change the pose name or create a thumbnail, see "Changing the Name and Information of Parts" .
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Applying a Pose
Apply a [Pose] to a 3D character in the [Document] window.

1 Select the tool
Select the [Move] tool from the [Tool] palette and select [Bone operation] from the [Sub Tool] palette.

2 Select the pose
Select the [Pose] to be applied from the [Object configuration] palette.

(1) Select the [Pose] to be applied from the [List].

(2) Click [Apply pose to character].

3 The pose is applied
The selected [Pose] is applied in the [Document] window.
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 Setting 3D Character Information
Set various information on 3D characters to be displayed in the [Material] palette and the settings screen of CLIP STU-
DIO PAINT.

Setting 3D Character Information
Set 3D character information. You can set a material name and thumbnail to be displayed when the 3D character is registered in the [Material] 
palette.

The thumbnail and material name set here are also displayed in CLIP STUDIO when the 3D character is published in CLIP STUDIO ASSETS.

1 Select the tool
Select the [Move] tool from the [Tool] palette and select [Bone operation] from the [Sub Tool] palette.

2 Pose the 3D character
Create a pose for the thumbnail by using the operations in the [Document] window and [Character configuration] palette.
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3 Setting 3D Character Information
Select the [Pose folder] on the [Character configuration] palette.

4 Set the thumbnail
Add the thumbnail for the 3D character in the [Character information] palette.

(1) Click [Thumbnail].

(2) Capture a thumbnail in the [Capture thumbnail] window. For information on operations in the [Capture thumbnail] window, see 
→"Capturing a Thumbnail" .

(3) The captured thumbnail is applied.

5 Set the name of the 3D character
Input information on the 3D character in the [Character information] palette.

(1) Double click the character name displayed in [Name]. When an input field is displayed, input the new name.

(2) Double click the area to the right of [Comment]. When an input field is displayed, input a comment.

For information on creating poses, see "Creating a Pose" .
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6 Set the height of the 3D character
Set the height of the 3D character.

(1) Select a sub tool other than [Bone operation] on the [Sub Tool] palette.

(2) Double click [Height] in the [3D Character information] palette and input the height of the character.

Comments are not displayed in CLIP STUDIO and CLIP STUDIO PAINT.
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Changing the Name and Information of Parts
When a part is first imported, the file name is displayed as the part name. This section describes how to change the name of parts.

1 Select the part
Select the part for which to change the name from the [Character configuration] palette.

(1) Display the [Parts folder] containing the texture to be exported in the [List].

(2) Click the name of the [Parts folder] for which to change the name.

2 Change the part name
Change the part name in the [Character information] palette.

(1) Double click the part name displayed in [Name].

(2) When an input field is displayed, input the new name.

Part names are displayed as 3D character material setting items in CLIP STUDIO PAINT. It is recommended that 
you choose a name that is easily recognizable.

The [Comment] field on the [Character information] palette can be input in the same way as for the name. Com-
ments are not displayed in CLIP STUDIO PAINT.
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3 The part name is changed
The name of the part folder on the [Character configuration] palette changes to the name input in step 2.

4 Add a thumbnail
Add a thumbnail for the selected part.

(1) Click [Thumbnail] in the [Character information] palette.

(2) Capture a thumbnail in the [Capture thumbnail] window. For information on operations in the [Capture thumbnail] window, see 
→"Capturing a Thumbnail" .

(3) The captured thumbnail is applied.

 You can also change the name by double clicking the part name in the [Parts folder] on the [Character config-
uration] palette.

 The names of a [Surface material], [Texture], etc. can be changed in the same way.
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 Mapping Default Bones to Different Bones
Default bones can be assigned to 3D characters that use other bones. Assigning default bones to a 3D model enables
it to be imported as a 3D character material in CLIP STUDIO PAINT.

For information on how to configure this, see "Default Bone Mapping Mode" .

 Adding Default Bones to a Model with No Bones
Default bones can be added to 3D characters with no bones. Assigning default bones to a 3D model enables it to be
imported as a 3D character material in CLIP STUDIO PAINT.

For information on how to configure this, see "Standard Bone Creation Mode" .

 Setting Natural Movement for Skirts
A rigid body can be set for skirts to create natural movement. When a rigid body is set for a skirt, the skirt moves with
the body when the character is posed in CLIP STUDIO PAINT.

For information on how to configure this, see "Skirt Settings Mode" .
CLIP STUDIO MODELER USER GUIDE 114



Functions in the 3D Character Setup Screen > Setting Camera Angles > Camera orientation
 Setting Camera Angles
The camera angle can be changed at times such as when saving works in the [Document] window, by using the mouse
with tools other than the [View] tool.

These operations can also be used to change the camera angle in the [Capture thumbnail] window and various modes
in the 3D Character Setup screen.

Camera orientation
Drag to change the camera orientation.

If this does not change the camera angle, press the [Space] key while dragging.

Camera position
Drag with the mouse wheel to move the camera directly up, down, left or right.

If this does not change the camera angle, press the [Space] key while dragging with the mouse wheel.

Drag

Drag the wheel
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Functions in the 3D Character Setup Screen > Setting Camera Angles > Camera distance
Camera distance
Right click and drag to move the camera back and forth.

If this does not change the camera angle, press the [Space] key while right clicking and dragging.

Right drag
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 Capturing a Thumbnail
This section explains operations in the [Capture thumbnail] window that is displayed when capturing a thumbnail for a
material. The captured thumbnail is displayed in the [Material] palette and the screen for setting materials in CLIP STU-
DIO PAINT.

1 Display the [Capture thumbnail] window
Click [Thumbnail] in the [Object information], [Background information] or [Character information] palette.

2 Capturing a Thumbnail
Capture the thumbnail in the [Capture thumbnail] window.

(1) Drag in the [Preview area] to set the desired angle for the thumbnail. The area displayed will be used for the thumbnail.

For [Movability], [Layout], [Angle], etc., capture a thumbnail of the applied settings in the [Document] window to 
create a thumbnail that clearly shows the setting information.
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Functions in the 3D Character Setup Screen > Capturing a Thumbnail > Facial Expressions for Characters
(2) Click [Complete].

3 The thumbnail is complete
The thumbnail in the [Object information], [Background information] or [Character information] palette changes to the one captured in the 
[Capture thumbnail] window.

Facial Expressions for Characters
If [Facial expression] is selected on the [Character configuration] palette, the [Capture thumbnail] window is not displayed when the [Thumb-
nail] for [Eyes] or a [Mouth] is clicked on the [Character information] palette.

Click the button for the [Eyes] or [Mouth] to be captured and click [Capture component thumbnail] to display the [Capture thumbnail] window. 
The operations in the [Capture thumbnail] window are the same as for all other thumbnails.

For information on how to set the angle, see "Setting Camera Angles".

To change a thumbnail, click [Thumbnail] on the [Object information] or [Character information] palette to display 
the [Capture thumbnail] window.
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 Saving a 3D Character
Save a work you have set up. Works can be saved in the following three ways.

Saving Project Data
Saving as a project file to be edited in CLIP STUDIO MODELER. It is recommended that you save works in this format first so that they can 
be edited again in CLIP STUDIO MODELER.

From the [File] menu, select [Save]. When the [Save As] dialog box is displayed, select [CLIP STUDIO MODELER Character file (*.csmc)] 
in [File type] and save the work.

The items that can be selected differ depending on the type of work being saved.

Saving in a Format for Importing in other CLIP STUDIO Products
Saving 3D files in CLIP STUDIO format enables them to be imported as 3D materials in CLIP STUDIO PAINT.

From the [File] menu, select [Save as]. When the [Save As] dialog box is displayed, select [CLIP STUDIO 3D character file (*.cs3c)] in [File 
type] and save the work.

Saving Project Data Saving as a project file to be edited in CLIP STUDIO MODELER.

Saving in a Format for Importing in 
other CLIP STUDIO Products

Saving as a 3D file that can be imported to CLIP STUDIO PAINT.

Registering to the Material Palette
Registering as a 3D material in the [Material] palette or CLIP STUDIO. 3D materials can 
be imported from CLIP STUDIO PAINT's [Material] palette immediately. They can also 
be published on CLIP STUDIO ASSETS.

Project files cannot be imported in CLIP STUDIO PAINT as they are. To use works in CLIP STUDIO PAINT, see 
"Saving in a Format for Importing in other CLIP STUDIO Products"  or "Registering to the Material Palette" .
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Registering to the Material Palette
Register works set up in CLIP STUDIO MODELER as 3D materials in the [Material] palette or CLIP STUDIO. Registered 3D materials can 
be imported from CLIP STUDIO PAINT's [Material] palette immediately. They can also be published in CLIP STUDIO ASSETS.

1 Select the command
From the [File] menu, select [Register as new material].

2 Set the material information
Set the material information and the location for saving the material in the [Material property] dialog box.

(1) Check [Material name]. To change it, change the input.

(2) Configure settings such as [Location to save material] and [Search tag].

(3) Click [OK].

For information on how to publish materials in CLIP STUDIO ASSETS, see "CLIP STUDIO TIPS"→"How to publish 
materials to ASSETS[Windows/macOS]".
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Tool List (3D Character 
Setup Screen)
This section introduces the functions and settings in the [Tool] palette of the 3D Character Setup screen by 
tool.
For information on how to use the [Tool] palette, see Tool-type Palettes.



Tool List (3D Character Setup Screen) > View Tool > Camera orientation
Tool List (3D Character Setup Screen)

 View Tool
[View] has the following sub tools.

Camera orientation
The camera orientation can be changed by dragging in the [Document] window.

Tool Property
Below are the setting items on the [Tool Property] palette when the [Camera orientation] sub tool is selected.

(1)  Fixed rotation angle
When you finish dragging at an angle that is almost directly forward or sideways, the camera orientation is fixed directly forward or side-
on. The projection method changes to [Parallel projection] when the camera orientation is forward or side-on.

Editing in the [Pose] group on the [Character information] palette cannot be done when the [View] tool is selected.
Editing in other groups can be done.

It can also be changed by dragging while pressing the [Space] key when using other tools.
If you are running this software on a device that uses full-width characters, make sure that the input is set to Eng-
lish or half-width characters when using this function.

The camera orientation changes.

Drag
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Tool List (3D Character Setup Screen) > View Tool > Camera position
Camera position
The camera can be moved, up, down, left or right in the screen by dragging in the [Document] window.

Camera distance
The camera can be moved back and forth in the screen by dragging in the [Document] window.

It can also be moved in the same way by dragging with the mouse wheel while pressing the [Space] key when 
using other tools.
If you are running this software on a device that uses full-width characters, make sure that the input is set to Eng-
lish or half-width characters when using this function.

It can also be moved in the same way by right clicking and dragging while pressing the [Space] key when using 
other tools.
If you are running this software on a device that uses full-width characters, make sure that the input is set to Eng-
lish or half-width characters when using this function.

The camera position moves.Drag

The camera moves back or forward.
Drag
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 Move Tool
The following sub tools are available when the [Move] tool is selected.

Move sketch
Selecting this displays the control points and outlines of the sketches imported in the [Sketch folder]. Dragging a control point allows you to 
transform the sketch. Dragging a sketch allows you to move the sketch to a new position.

(1) Same size scale
Drag to scale up/down while keeping the original aspect ratio of the texture.

(2) Stretch (Width)
Drag to change the width of the texture.

(3) Stretch (Height)
Drag to change the height of the texture.

Editing in the [Pose] group on the [Character information] palette cannot be done when the [Move sketch] sub 
tool is selected.
Editing in other groups can be done.
CLIP STUDIO MODELER USER GUIDE 124



Tool List (3D Character Setup Screen) > Move Tool > Move parts
Move parts
Click a part in the [Document] window to select the part. When a part is selected, manipulators are displayed at the origin of the part, enabling 
the origin and orientation to be set.

(1) Origin
The center point where the arrows intersect is the origin of the part.

Click and drag the controller (blue circle) to move the part freely.

(2) Move (x)
Click and drag the red arrow (X axis) to move the selected part in the direction of the arrow.

The [Origin] value in the [Character information] palette changes according to the movement of the part.

(3) Move (y)
Click and drag the green arrow (Y axis) to move the selected part in the direction of the arrow.

The [Origin] value in the [Character information] palette changes according to the movement of the part.

(4) Move (z)
Click and drag the blue arrow (Z axis) to move the selected part in the direction of the arrow.

The [Origin] value in the [Character information] palette changes according to the movement of the part.

(5) Rotate back and forth (x)
Click and drag the [Red] ring. The selected part rotates in the direction of the ring.

The [Orientation] value in the [Character information] palette changes according to the rotation of the part.

(6) Rotate horizontally (y)
Click and drag the [Green] ring. The selected part rotates in the direction of the ring.

The [Orientation] value in the [Character information] palette changes according to the rotation of the part.

(7) Rotate left/right (z)
Click and drag the blue ring. The selected part rotates in the direction of the ring.

The [Orientation] value in the [Character information] palette changes according to the rotation of the part.

 Parts that are not displayed in the [Document] window cannot be edited.

 Parts can also be edited by selecting them from the [Character configuration] palette and editing them with 
the [Move parts] tool.

 Editing in the [Pose] group on the [Character information] palette cannot be done when the [Move parts] sub 
tool is selected.
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Tool List (3D Character Setup Screen) > Move Tool > Bone operation
Bone operation
Select and rotate an area (bone) of a 3D character.

Manipulators are displayed when you click an area in the [Document] window. These can be moved to rotate (bend or twist) parts.

(1) Twisted rotation (red)
Drag along the red ring. Rotates the selected part in the direction of the ring.

(2) Bending rotation (green)
Drag along the green ring. Rotates the selected part in the direction of the ring.

(3) Bending rotation (blue)
Drag along the blue ring. Rotates the selected part in the direction of the ring.

(4) Movable range
Displays the range in which the part can be moved.

Editing in the [Pose] group on the [Character information] palette can be done when the [Bone operation] sub tool 
is selected.
However, editing in other groups cannot be done.

[Twisted rotation (red)], [Bending rotation (green)], [Bending rotation (blue)] are only displayed when rotation in 
the corresponding direction is possible.
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Tool List (3D Character Setup Screen) > Textures > Paste texture
 Textures
The texture sub tool is used to paste textures to parts. Pasted textures can also be moved or transformed.

Paste texture
Click the part where you want to paste a texture and drag to paste the texture. The image for the texture can be imported from the [Tool Prop-
erty] palette.

Pasting Textures
Paste textures to parts using the [Paste texture] sub tool.

1 Select the tool
Select the [Texture] tool from the [Tool] palette and select the [Paste texture] sub tool from the [Sub Tool] palette.

2 Select the part
Select the part for which to paste a texture from the [Character configuration] palette.

Selecting the [Texture] tool enables editing in the [Body] and [Face] groups on the [Character information] palette.
However, editing in other groups cannot be done.
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Tool List (3D Character Setup Screen) > Textures > Paste texture
3 Import a texture
Click [Texture image] in the [Tool Property] palette and select the image file for the texture from the dialog box for selecting a file.

4 Pasting a texture
Drag in the [Document] window to make a rectangle surrounding the area in which to paste the texture.

The texture color darkens in the position where the texture is pasted. The texture is pasted according to the shape of the part.

The pasted texture is added to [Additional texture] in the [Character configuration] palette.

Image materials for textures can be imported by dragging and dropping a character texture from the [Material] 
palette to [Texture image] on the [Tool Property] palette.

Drag
CLIP STUDIO MODELER USER GUIDE 128



Tool List (3D Character Setup Screen) > Textures > Paste texture
Tool Property
Below are the setting items on the [Tool Property] palette when the [Paste texture] sub tool is selected.

(1) Same size
Maintains the original aspect ratio of the texture image when dragging during pasting.

(2) Texture image
When clicked, displays the dialog box for selecting a file. Select the file to be used as a texture. The file is imported to the [Tool Property] 
palette and a preview is displayed in [Texture image].

Image materials for textures can be imported by dragging and dropping an image material from the [Material] palette to [Texture image].

The size and position of pasted textures can be adjusted using the [Move texture] sub tool. For details, see "Move 
texture" .

There are no setting items on the [Tool Property] palette when the [Move texture] palette is selected.

File formats that can be imported BMP, JPG, PNG, TIFF, TGA
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Tool List (3D Character Setup Screen) > Textures > Move texture
Move texture
When this is selected, the texture "floats" in the [Document] window and the control points and outline are displayed. Drag the control points to 
transform the texture. Drag the texture to change the position of the texture.

(1) Same size scale
Drag to scale up/down while keeping the original aspect ratio of the texture.

(2) Stretch (Width)
Drag to change the width of the texture.

(3) Stretch (Height)
Drag to change the height of the texture.

The following operations can be performed with the [Move texture] sub tool depending on the position that is clicked or dragged.

When a texture is clicked
Textures mapped to parts will "float" in the [Document] window.

Click a floating texture to map it to a part.

When a texture is dragged This moves the floating texture.
CLIP STUDIO MODELER USER GUIDE 130



Character Configuration 
Palette
The [Character configuration] palette is used to manage multiple parts such as [Body], [Face], [Hair], and 
[Accessories] in a folder. This section describes the functions of the [Character configuration] palette.

 Functions of the Character Configuration Palette



Character Configuration Palette > Functions of the Character Configuration Palette
Character Configuration Palette

 Functions of the Character Configuration Palette
This section describes the common functions of the [Character configuration] palette.

A. Groups
The settings that can be configured on the [Character configuration] palette are divided into groups.

Click each group button to switch the settings in the [List] and [Command Bar].

(1) Sketch
Configure settings related to sketch image files.

(2) Body
Import and manage body parts for 3D characters and configure related settings.

(3) Face
Import and manage face parts for 3D characters and configure related settings.

(4) Hair
Import and manage hair parts for 3D characters and configure related settings.

(5) Accessories
Import and manage accessory parts for 3D characters and configure related settings.

(6) Pose data
Manage poses for 3D characters and configure related settings.

B. List
Clicking the group buttons in [Group] displays advanced settings for the selected group.

The settings vary depending on the selected group. For details, see the items indicated below.

C. Open Folder/Close Folder
Open and close folders. Clicking this icon toggles the folder between open and closed.

D. Visible/Invisible
Set display state of folders and sketches. Clicking this icon toggles between display and hide.

Sketch See "Sketch" .

Body See "Body" .

Face See "Face" .

Hair See "Hair" .

Accessories See "Accessories" .

Pose data See "Pose data" .

A

B C

D E F

G
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E. Element name
The name of each element such as parts and textures. Double click to rename.

F. Lock
Enable/disable editing Clicking this icon toggles the layer between enabling and disabling editing.

G. Command Bar
3D files can be imported to the [List] and various operations from the [List] can be performed.

The displayed items vary depending on the selected group. For details, see the items indicated below.

Sketch See "Sketch" .

Body See "Body" .

Face See "Face" .

Hair See "Hair" .

Accessories See "Accessories" .

Pose data See "Pose data" .
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Sketch
When [Sketch] is selected from [Group], a sketch is imported to the [Document] window and management items are displayed.

This section describes the functions of the [List] and [Command Bar]. For information on other functions, see "Functions of the Character Con-
figuration Palette" .

List
(1) Sketch folder

The folder where sketch images are stored. Multiple sketch images can be imported and managed. It is not possible to delete the [Sketch 
folder] or change its name.

(2) Sketch image
The image imported as a reference for the creation of a 3D character. Click [Visible/Invisible] for [Sketch image] to toggle between dis-
playing and hiding the sketch in the [Document] window. Only one sketch can be displayed at once. Double click the name to rename the 
sketch.

Command Bar
(1) Add new

Cannot be used.

(2) Add from file
Imports an image file to be used as a sketch in the [Character configuration] palette.

(3) Add from material
Cannot be used.

(4) Duplicate node
Duplicates a sketch selected from the [List].

(5) Delete node
Deletes a sketch selected from the [List].

File formats that can be imported BMP, JPG, PNG, TIFF, TGA

Command Bar
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Body
When [Body] is selected in [Group], items for importing body parts for 3D characters and storing and managing various settings are displayed.

This section describes the functions of the [List] and [Command Bar]. For information on other functions, see "Functions of the Character Con-
figuration Palette" .

List
(1) Body folder

The folder where all [Body parts folders] are stored. Multiple [Body parts folders] can be imported and managed in the [Body folder]. It is 
not possible to delete the [Body folder] or change its name.

(2) Body parts folders
The folders created when 3D files for bodies are imported to the [Body folder].

Click [Visible/Invisible] for [Body parts folder] to toggle between displaying and hiding the corresponding body parts in the [Document] 
window. Only one type of each body part can be displayed at a time. Double clicking the folder name allows you to enter a folder name. 
The folder name input here is displayed in the settings screens in CLIP STUDIO PAINT.

Each folder contains [Surface material information], [Additional texture], [Physics settings] and [Shape] settings.

(3) Surface material information folder
The folder for managing and storing the textures used as the base for bodies.

(4) Surface material
Preset surface materials for 3D files. Texture images may be linked to surface materials.

(5) Additional texture folder
The folder for managing textures pasted using tools such as the [Paste texture] tool. Multiple textures can be stored.

(6) Texture (Paste texture)
The texture image pasted to the body parts. Textures are created by pasting a texture to a body using the [Paste texture] tool. Double click-
ing allows you to enter a texture name.

(7) Physics settings
Click this to configure the settings for the applied physics in the [Character information] palette.

Command Bar
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(8) Shape
When a 3D file containing shape settings is imported, this can be clicked to display the settings of the shape in the [Character information] 
palette.

Command Bar
(1) Add new

Cannot be used.

(2) Add from file
3D files for bodies are imported in the [Character configuration] palette.

(3) Add from material
Materials in the [Material] palette can be added to the [Character configuration] palette.

Clicking these displays the [Body] dialog box. Select a part in the [Material] palette and click [OK] to import the part.

(4) Duplicate node
Duplicates an item selected from the [List]. Textures in [Body parts folders] and the [Additional texture folder] can be duplicated. Other 
items cannot be duplicated.

(5) Delete node
Deletes an item selected from the [List]. Textures in [Body parts folder]s and the [Additional texture folder] can be deleted. Other items 
cannot be deleted.

The displayed shape settings vary depending on the imported model. Shapes can be previewed in CLIP STUDIO 
MODELER, but operations for shapes cannot be performed in CLIP STUDIO PAINT.

File formats that can be imported Files in CLIP STUDIO MODELER format (extension: csmf), fbx, 6kt, 6kh, lwo, obj

Materials are not displayed in the [Body] dialog box if there are no materials that can be used as [Body parts].
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Face
When [Face] is selected in [Group], items for importing face parts for 3D characters and storing and managing various settings are displayed.

This section describes the functions of the [List] and [Command Bar]. For information on other functions, see "Functions of the Character Con-
figuration Palette" .

List
(1) Face folder

The folder where all [Face parts folders] are stored. Multiple [Face parts folder]s can be imported and managed in the [Face folder]. It is 
not possible to delete the [Face folder] or change its name.

(2) Face parts folder
The folders created when 3D files for faces are imported to the [Face folder].

Click [Visible/Invisible] for [Face parts folder] to toggle between displaying and hiding the corresponding face parts in the [Document] 
window. Only one type of each face part can be displayed at a time. Double clicking the folder name allows you to enter a folder name. 
The folder name input here is displayed in the settings screens in CLIP STUDIO PAINT.

Each folder contains settings such as [Surface material (for facial expression)], [Facial expression], [Physics settings] and [Shape].

(3) Surface material (for facial expression)
The texture used as the base for face parts.

(4) Facial expression folder
A list for managing the facial expressions of 3D characters.

Face parts folders have a different configuration if [Use facial expression texture] is turned off on the [Character 
information] palette when the face parts folder is selected.

Command Bar
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(5) Facial expression
Click [Visible/Invisible] to switch the facial expression of the 3D character in the [Document] window.

Double click the facial expression name to input or change the name. The facial expression name input here is displayed in the settings 
screens in CLIP STUDIO PAINT.

(6) Physics settings
Click this to configure the settings for the applied physics in the [Character information] palette.

(7) Shape
When a 3D file containing shape settings is imported, this can be clicked to display the settings of the shape in the [Character information] 
palette.

(8) Surface material information folder
The folder for managing and storing the textures used as the base for face parts. This is displayed when [Use facial expression texture] is 
turned off in the [Character information] palette.

(9) Surface material
Preset surface materials for 3D files. Texture images may be linked to surface materials.

This is displayed when [Use facial expression texture] is turned off in the [Character information] palette.

(10)Additional texture folder
The folder for managing textures pasted using tools such as the [Paste texture] tool. Multiple textures can be stored. This is displayed when 
[Use facial expression texture] is turned off in the [Character information] palette.

(11) Texture (Paste texture)
The texture image pasted to the face parts. Textures are created by pasting a texture to a face using the [Paste texture] tool. Double clicking 
allows you to enter a texture name. This is displayed when [Use facial expression texture] is turned off in the [Character information] pal-
ette.

Command Bar
(1) Add new

Cannot be used.

(2) Add from file
3D files for faces (extension: fbx) are imported in the [Character configuration] palette.

(3) Add from material
Materials in the [Material] palette can be added to the [Character configuration] palette.

Clicking these displays the [Face] dialog box. Select a part in the [Material] palette and click [OK] to import the part.

The names of the facial expressions created in the default settings ([Default], [Smile], [Anger] and [Sad]) cannot 
be changed by double clicking.

The displayed shape settings vary depending on the imported model. Operations for shapes can be performed in 
CLIP STUDIO MODELER, but not in CLIP STUDIO PAINT.

Materials are not displayed in the [Face] dialog box if there are no materials that can be used as [Face parts].
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(4) Duplicate node
Duplicates an item selected from the [List]. In the [Face] folder the following items can be duplicated.
 Face parts folders
 Facial expressions
 Texture (Paste texture)

(5) Delete node
Deletes an item selected from the [List]. In the [Face] folder the following items can be deleted.
 Face parts folders
 Facial expressions
 Texture (Paste texture)

(6) Export facial expression
When a [Face parts folder] with [Use facial expression texture] turned on is selected, the facial expression texture can be exported in Pho-
toshop document format (extension: psd). For details, see "Exporting Facial Expression Textures" .

(7) Import facial expression
When a [Face parts folder] with [Use facial expression texture] turned on is selected, facial expression textures can be imported. Photo-
shop document format (extension: psd) can be imported. For details, see "Importing Facial Expression Textures" .
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Hair
When [Hair] is selected in [Group], items for importing hair parts for 3D characters and storing and managing various settings are displayed.

This section describes the functions of the [List] and [Command Bar]. For information on other functions, see "Functions of the Character Con-
figuration Palette" .

List
(1) Hair folder

The folder where all [Hair parts folders] are stored. Multiple [Hair parts folders] can be imported and managed in the [Hair folder]. It is not 
possible to delete the [Hair folder] or change its name.

(2) Hair parts folders
The folders created when 3D files for hair are imported to the [Hair folder].

Click [Visible/Invisible] for [Hair parts folder] to toggle between displaying and hiding the corresponding hair parts in the [Document] 
window. Only one type of hair can be displayed at a time. Double clicking the folder name allows you to enter a folder name. The folder 
name input here is displayed in the settings screens in CLIP STUDIO PAINT.

Each folder contains settings for [Surface material information], [Physics settings] and [Shape].

(3) Surface material information folder
The folder for managing and storing the textures used as the base for hair.

(4) Surface material
Preset surface materials for 3D files. Texture images may be linked to surface materials.

(5) Physics settings
Click this to configure the settings for the applied physics in the [Character information] palette.

(6) Shape
When a 3D file containing shape settings is imported, this can be clicked to display the settings of the shape in the [Character information] 
palette.

Command Bar
(1) Add new

Cannot be used.

(2) Add from file
Hair files (extension: fbx) are imported in the [Character configuration] palette.

The displayed shape settings vary depending on the imported model. Operations for shapes can be performed in 
CLIP STUDIO MODELER, but not in CLIP STUDIO PAINT.

Command Bar
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(3) Add from material
Materials in the [Material] palette can be added to the [Character configuration] palette.

Clicking these displays the [Hair] dialog box. Select a part in the [Material] palette and click [OK] to import the part.

(4) Duplicate node
Duplicates the selected [Hair parts folder] from the [List].

(5) Delete node
Deletes the selected [Hair parts folder] from the [List].

Accessories
When [Accessories] is selected in [Group], items for importing accessory parts for 3D characters and storing and managing various settings are 
displayed.

This section describes the functions of the [List] and [Command Bar]. For information on other functions, see "Functions of the Character Con-
figuration Palette" .

List
(1) Accessories folder

The folder where all [Accessory parts folders] are stored. Multiple [Accessory parts folder]s can be imported and managed in the [Acces-
sories folder]. It is not possible to delete the [Accessories folder] or change its name.

(2) Accessory parts folder
The folders created when 3D files for accessories are imported to the [Accessories folder].

Click [Visible/Invisible] for [Accessory parts folder] to toggle between displaying and hiding the corresponding accessory parts in the 
[Document] window. Multiple accessory parts can be displayed at once. Double clicking the folder name allows you to enter a folder 
name. The folder name input here is displayed in the settings screens in CLIP STUDIO PAINT.

Each folder contains settings for [Surface material information] and [Physics settings].

(3) Surface material information folder
The folder for managing and storing the textures used as the base for accessories.

(4) Surface material
Preset surface materials for 3D files. Texture images may be linked to surface materials.

(5) Physics settings
Click this to configure the settings for the applied physics in the [Character information] palette.

Command Bar
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Command Bar
(1) Add new

Cannot be used.

(2) Add from file
Accessory files (extension: fbx) are imported in the [Character configuration] palette.

(3) Add from material
Materials in the [Material] palette can be added to the [Character configuration] palette.

Clicking these displays the [Accessories] dialog box. Select a part in the [Material] palette and click [OK] to import the part.

(4) Duplicate node
Duplicates the selected [Accessory parts folder] from the [List].

(5) Delete node
Deletes the selected [Accessory parts folder] from the [List].

Pose data
When [Pose data] is selected in [Group], items for managing poses that can be linked to 3D characters are displayed.

This section describes the functions of the [List] and [Command Bar]. For information on other functions, see "Functions of the Character Con-
figuration Palette" .

List
(1) Pose data folder

The folder where all [Pose] items are stored. Multiple [Pose] items can be imported and managed in the [Pose data folder]. It is not possi-
ble to delete the [Pose data folder] or change its name.

(2) Pose
[Pose] items for 3D characters can be recorded here. One [Pose] is recorded for each item. Double click the pose name to input or change 
the [Pose] name.

Command Bar
(1) Add new

Click this to add a [Pose].

(2) Add from file
Pose files (extension: pep) are imported in the [Character configuration] palette.

 To select [Pose] from the [Character configuration] palette, select the [Move] tool and select [Bone operation] 
from the [Sub Tool] palette.

 Operations for pose data can be performed in CLIP STUDIO MODELER, but not in CLIP STUDIO PAINT.

Command Bar
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(3) Add from material
Materials registered to the [Material] palette can be added to the [Character configuration] palette.

Clicking these displays the [Pose data] dialog box. Select a pose in the [Material] palette and click [OK] to import the pose.

(4) Duplicate node
Duplicates a [Pose] selected from the [List].

(5) Delete node
Deletes a [Pose] selected from the [List].

(6) Apply pose to character
Apply a [Pose] selected from the [List] to a 3D character in the [Document] window.

(7) Save character pose
Saves the pose of the 3D character in the [Document] window to a [Pose] selected from the [List].

Menu of the Character Configuration Palette
This section describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the [Char-
acter configuration] palette.

Hide character configuration palette
Hides the [Character configuration] palette.

 

To display the [Character configuration] palette again, select [Window] menu → [Character configuration].
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Palette
The [Character information] palette is used to configure advanced settings for items selected on the [Character 
configuration] palette.
This section describes the functions of the [Character information] palette.

 Functions of the Character Information Palette
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Character Information Palette

 Functions of the Character Information Palette
This section describes the functions and names of each part of the [Character information] palette. The settings that
can be configured in the [Character information] palette vary depending on the item selected in the [List] of the [Char-
acter configuration] palette.

 "Standard display" 

 "When a sketch is selected" 

 "When a part is selected" 

 "When a surface material in a surface material information folder is selected" 

 "When a texture in [Additional texture] is selected" 

 "When a texture in a facial expression is selected" 

 "When physics settings are selected" 

 "When a shape is selected" 

 "When a pose is selected" 

Standard display
The following settings can be configured when no items are selected in the [Character configuration] palette.

(1) Thumbnail of character material
A thumbnail of the character material. This is displayed in CLIP STUDIO and the [Material] palette.

Click the thumbnail to display the [Capture thumbnail] window where a thumbnail can be captured for the part. For information on how to 
configure this, see "Capturing a Thumbnail" .

(2) Name
Displays the name of the edited material. Click this field to input a material name.

(3) Comment
A comment about the 3D character material can be set. Click this field to input a comment. Information such as a description of the mate-
rial can be entered here.

This screen is displayed even when the selected item is locked or there are no items that can be configured indi-
vidually.
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(4) Height
The height of the 3D character can be set. Click this field to input the height.

The height of the 3D character is applied when the character is imported in CLIP STUDIO PAINT. If you create two 3D character materi-
als consisting of the same 3D model with different heights, they will be imported as shown below.

3D character material set with a height of 160cm

3D character material set with a height of 100cm　　　　　　
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When a sketch is selected
The following settings can be configured after selecting [Sketch image] in the [List] when [Sketch] is selected in the [Group] of the [Character 
configuration] palette.

(1) Import texture
Displays a preview of the sketch image selected in the [Character configuration] palette. Click this to display the dialog box for selecting a 
file. Import the image to be used as the [Sketch image]. This replaces the [Sketch image] being edited.

Image materials for textures can be imported as a [Sketch image] by dragging and dropping an image material from the [Material] palette 
to [Import texture].

(2) Sketch image name
Displays the name of the sketch image being edited. Double click this to input a sketch image name. When the sketch image name is 
changed, the sketch image name in the [Character configuration] palette also changes.

(3) Opacity
Allows you to configure the opacity of the [Sketch image].

(4) Edit texture in PAINT
Cannot be used.

(5) Export texture
Exports the sketch image displayed in [Import sketch image] in PNG format.

(6) Paste texture
Replaces the selected [Sketch image] with the image on the clipboard.

A [Sketch image] cannot be edited in the [Character information] palette when it is hidden.
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When a part is selected
When a part is selected in the [List] of each group in the [Character configuration] palette, the settings that can be configured differ depending 
on the selected part.

 "Body parts folders" 

 "Face parts folders" 

 "Hair parts folders" 

 "Accessory parts folders" 

Body parts folders
The following settings can be configured in the [Character information] palette when a [Body parts folder] is selected in the [List].

(1) Thumbnail
The thumbnail of the [Body parts folder].

Click the thumbnail to display the [Capture thumbnail] window where a thumbnail can be captured for the part. For information on how to 
configure this, see "Capturing a Thumbnail" .

(2) Name
Displays the name of the edited part. Click this field to input a part name. The input name is applied to the [Character configuration] pal-
ette.

(3) Comment
A comment about the [Body parts folder] can be set. Click this field to input a comment. Information such as a description of the [Body 
parts folder] can be entered here.

(4) Origin
Set the [Origin x coordinate], [Origin y coordinate] and [Origin z coordinate] of the [Body parts folder]. The position of body parts can be 
adjusted by inputting numeric values.

The origin of a [Body parts folder] is displayed by selecting the [Move parts] tool. The [Move parts] tool can also be used to adjust the 
position of body parts. For details, see "Move parts" .

A [Body parts folder] cannot be edited in the [Character information] palette when it is hidden.
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(5) Direction
Set [Rotate around x axis], [Rotate around y axis] and [Rotate around z axis] for the [Body parts folder]. The angle of body parts can be 
adjusted relative to the origin by inputting numeric values.

The origin of a [Body parts folder] is displayed by selecting the [Move parts] tool. The [Move parts] tool can also be used to adjust the ori-
entation of body parts. For details, see "Move parts" .

(6) Scale
The size of the [Body parts folder] can be set using the slider.

(7) Use as complete character
Turn this on to register the selected [Body parts folder] as a full 3D character combining the [Body], [Face] and [Hair].

Use this when the full 3D character, including the [Body], [Face] and [Hair], has been loaded to the [Character configuration] palette.

(8) Bake additional texture
Bakes textures pasted using tools such as the [Paste texture] tool.

Baked textures are moved from the [Additional texture folder] to the [Surface material information folder].

(9) Standard bone mapping
When the bone configuration of the selected [Body parts folder] is different from the standard bones, the standard bones can be assigned. 
Click this to switch to the standard bone mapping settings mode. For information on how to configure the standard bone mapping settings, 
see "Default Bone Mapping Mode" .

(10)Create standard bone
When the selected [Body parts folder] does not have bones, standard bones can be created. Click this to switch to the standard bone cre-
ation mode. For information on creating standard bones, see "Standard Bone Creation Mode" .

(11) Skirt settings
Skirts in [Body parts folders] can be set to flutter according to the movement of the 3D character. Click this to switch to skirt settings 
mode. For information on how to configure skirt settings, see "Skirt Settings Mode" .

Once a texture is baked, it can no longer be edited with the [Move texture] tool.
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Face parts folders
The following settings can be configured in the [Character information] palette when a [Face parts folder] is selected in the [List].

(1) Thumbnail
The thumbnail of the [Face parts folder].

Click the thumbnail to display the [Capture thumbnail] window where a thumbnail can be captured for the part. For information on how to 
configure this, see "Capturing a Thumbnail" .

(2) Name
Displays the name of the edited part. Double click this field to input a part name. The input name is applied to the [Character configura-
tion] palette.

(3) Comment
A comment about the [Face parts folder] can be set. Click this field to input a comment. Information such as a description of the [Face 
parts folder] can be entered here.

(4) Origin
Set the [Origin x coordinate], [Origin y coordinate] and [Origin z coordinate] of the [Face parts folder]. The position of face parts can be 
adjusted by inputting numeric values.

The origin of a [Face parts folder] is displayed by selecting the [Move parts] tool. The [Move parts] tool can also be used to adjust the 
position of face parts. For details, see "Move parts" .

(5) Direction
Set [Rotate around x axis], [Rotate around y axis] and [Rotate around z axis] for the [Face parts folder]. The angle of face parts can be 
adjusted relative to the origin by inputting numeric values.

The origin of a [Face parts folder] is displayed by selecting the [Move parts] tool. The [Move parts] tool can also be used to adjust the ori-
entation of face parts. For details, see "Move parts" .

(6) Scale
The size of the [Face parts folder] can be set using the slider.

(7) Use facial expression texture
Turn this on to set the facial expression of a 3D character as a facial expression texture. Using facial expression textures makes it possible 
to set multiple facial expressions in one [Face parts folder]. Eye and mouth movements can also be set in the texture.

When this is turned off, the texture is stored in the [Surface material information] folder like that of the body and hair. If multiple facial 
expressions need to be set for 3D characters in this case, a separate [Face parts folder] needs to be set for each facial expression.

A [Face parts folder] cannot be edited in the [Character information] palette when it is hidden.
CLIP STUDIO MODELER USER GUIDE 150



Character Information Palette > Functions of the Character Information Palette > When a part is selected
(8) Export PSD file for facial expression settings
When a [Face parts folder] with [Use facial expression texture] turned on is selected, the facial expression texture can be exported in Pho-
toshop document format (extension: psd). For details, see "Exporting Facial Expression Textures" .

(9) Import PSD file for facial expression settings
When a [Face parts folder] with [Use facial expression texture] turned on is selected, facial expression textures can be imported. Photo-
shop document format (extension: psd) can be imported. For details, see "Importing Facial Expression Textures" .

Hair parts folders
The following settings can be configured in the [Character information] palette when a [Hair parts folder] is selected in the [List].

(1) Thumbnail
The thumbnail of the [Hair parts folder].

Click the thumbnail to display the [Capture thumbnail] window where a thumbnail can be captured for the part. For information on how to 
configure this, see "Capturing a Thumbnail" .

(2) Name
Displays the name of the edited part. Double click this field to input a part name. The input name is applied to the [Character configura-
tion] palette.

(3) Comment
A comment about the [Hair parts folder] can be set. Click this field to input a comment. Information such as a description of the [Hair parts 
folder] can be entered here.

(4) Origin
Set the [Origin x coordinate], [Origin y coordinate] and [Origin z coordinate] of the [Hair parts folder]. The position of hair parts can be 
adjusted by inputting numeric values.

The origin of a [Hair parts folder] is displayed by selecting the [Move parts] tool. The [Move parts] tool can also be used to adjust the posi-
tion of hair parts. For details, see "Move parts" .

 For information on how to configure the settings of facial expression textures, see "Editing Facial Expres-
sions" .

 [Use facial expression texture] cannot be set if there are multiple [Surface materials] in the [Surface material 
information folder] of the [Face parts folder].

A [Hair parts folder] cannot be edited in the [Character information] palette when it is hidden.
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(5) Direction
Set [Rotate around x axis], [Rotate around y axis] and [Rotate around z axis] for the [Hair parts folder]. The angle of hair parts can be 
adjusted relative to the origin by inputting numeric values.

The origin of a [Hair parts folder] is displayed by selecting the [Move parts] tool. The [Move parts] tool can also be used to adjust the ori-
entation of hair parts. For details, see "Move parts" .

(6) Scale
The size of the [Hair parts folder] can be set using the slider.

Accessory parts folders
The following settings can be configured in the [Character information] palette when an [Accessory parts folder] is selected in the [List].

(1) Thumbnail
The thumbnail of the [Accessory parts folder].

Click the thumbnail to display the [Capture thumbnail] window where a thumbnail can be captured for the part. For information on how to 
configure this, see "Capturing a Thumbnail" .

(2) Name
Displays the name of the edited part. Double click this field to input a part name. The input name is applied to the [Character configura-
tion] palette.

(3) Comment
A comment about the [Accessory parts folder] can be set. Click this field to input a comment. Information such as a description of the 
[Accessory parts folder] can be entered here.

(4) Attachment destination
Select the bone where you want to attach the [Accessory parts folder].

(5) Origin
Set the [Origin x coordinate], [Origin y coordinate] and [Origin z coordinate] of the [Accessory parts folder]. The position of accessory 
parts can be adjusted by inputting numeric values.

The origin of an [Accessory parts folder] is displayed by selecting the [Move parts] tool. The [Move parts] tool can also be used to adjust 
the position of accessory parts. For details, see "Move parts" .

An [Accessory parts folder] cannot be edited in the [Character information] palette when it is hidden.

For information on the names of the bones, see "Specifications of Deandard Bones (Guide to Creating Movable 
Models)"
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(6) Orientation
Set [Rotate around x axis], [Rotate around y axis] and [Rotate around z axis] for the [Accessory parts folder]. The angle of accessory parts 
can be adjusted relative to the origin by inputting numeric values.

The origin of an [Accessory parts folder] is displayed by selecting the [Move parts] tool. The [Move parts] tool can also be used to adjust 
the orientation of accessory parts. For details, see "Move parts" .

(7) Scale
The size of the [Accessory parts folder] can be set using the slider.

When a surface material in a surface material information folder is selected
The following settings can be configured in the [Character information] palette when a [Surface material] stored in the [Surface material infor-
mation folder] of the [Character configuration] palette is selected.

(1) Import texture
When a texture image is linked to the [Surface material] selected in the [Character configuration] palette, a preview of the texture image is 
displayed. Click this to display the dialog box for selecting a file. Import the image file to be set as the texture and replace the texture 
image.

(2) Name
Displays the name of the selected surface material. Double clicking the field allows you to enter a surface material name. The input name 
is applied to the [Character configuration] palette.

(3) Diffused light
The RGB value for the [Diffused light] of the [Surface material] can be adjusted.

[Diffused light] is light that creates an even (diffused) reflection when the light source illuminates a [Surface material].

(4) Specular light
The RGB value for the [Specular light] of the [Surface material] can be adjusted.

[Surface material information folders] are stored in parts folders in the [Body], [Face], [Hair] and [Accessories] 
groups, 
except for [Face parts folders] for which [Use facial expression texture] is set.

File formats that can be imported BMP, JPG, PNG, TIFF, TGA

[Diffused light] cannot be set when a texture image is linked to the [Surface material]. If a texture image is linked, 
the [Texture image] is displayed in the [Character information] palette.
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(5) Ambient light
The RGB value for the [Ambient light] of the [Surface material] can be adjusted.

[Ambient light] is light that illuminates the 3D character evenly from all directions.

(6) Emitted light
The RGB value for the [Emitted light] of the [Surface material] can be adjusted.

(7) Luminosity
The luminosity of the [Surface material] can be set.

(8) Opacity
The opacity of the [Surface material] can be changed.

(9) Edit in PAINT
If CLIP STUDIO PAINT is installed on your computer or device, the texture linked to the selected [Surface material] can be edited in 
CLIP STUDIO PAINT.

For details, see "Editing Textures in CLIP STUDIO PAINT" .

(10)Export texture
The texture linked to the selected [Surface material] can be exported as an image in PNG format.

(11) Paste texture
Replaces the texture linked to the selected [Surface material] with the image from the clipboard.

[Edit in PAINT] cannot be set when a texture image is linked to the [Surface material].

[Export texture] cannot be set when a texture image is linked to the [Surface material].

[Paste texture] cannot be set when a texture image is linked to the [Surface material].
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When a texture in [Additional texture] is selected
The following settings can be configured in the [Character information] palette when a [Texture] stored in [Additional texture] in the [Charac-
ter configuration] palette is selected.

(1) Import texture
Displays a preview of the texture image. Click this to display the dialog box for selecting a file. Import the image file to be set as the tex-
ture and replace the texture image.

(2) Name
Displays the texture name. Click this field to input a texture name. The input name is applied to the [Character configuration] palette.

(3) Edit in PAINT
If CLIP STUDIO PAINT is installed on your computer or device, the texture can be edited in CLIP STUDIO PAINT.

(4) Export texture
Exports the texture as an image in PNG format.

(5) Paste texture
Replaces the texture with the image from the clipboard.

File formats that can be imported BMP, JPG, PNG, TIFF, TGA
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When a texture in a facial expression is selected
The following settings can be configured in the [Character information] palette when a [Texture] stored in [Facial expression] in the [Character 
configuration] palette is selected.

(1) Thumbnail
The thumbnail of the [Facial expression]. Click the thumbnail to display the [Capture thumbnail] window where a thumbnail can be cap-
tured for the facial expression. For information on how to configure this, see "Capturing a Thumbnail" .

(2) Name
Displays the name of the edited facial expression. Double clicking the field allows you to enter a facial expression name. The input name 
is applied to the [Character configuration] palette.

(3) Comment
A comment about the [Facial expression] can be set. Right click the item name to input text. Information such as a description can be 
entered here.

(4) Eyes
Click each button to switch the eye expression of the 3D character.

(5) Mouth
Click each button to switch the mouth expression of the 3D character.

(6) Capture component thumbnail
Click the thumbnail to display the [Capture thumbnail] window where a thumbnail can be captured for the selected [Eye] or [Mouth] 
expression. For information on how to configure this, see "Facial Expressions for Characters" .

The [Names] created in the default settings ([Default], [Smile], [Anger] and [Sad]) cannot be changed by double 
clicking.
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When physics settings are selected
The following settings can be configured in the [Character information] palette when [Physics settings] in the [Character configuration] palette 
are selected.

A. Target bone
Click this to display a list of bones. Select the bone to which you want to apply physics settings.

B. Rigid body
Turn this on to display the rigid body settings.

The rigid body is a mass used to configure physics operations for the character. One can be created for each bone. For information on rigid 
body settings, see "Rigid bodies" .

C. Joints
Turn this on to display the joint settings.

Joints are the connection areas between rigid bodies. Multiple joints can be created for each rigid body. For information on joint settings, 
see "Joints" .

A
B C

The boxes or capsule shapes 

around the character are rigid bodies.
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Rigid bodies
The following settings are displayed when [Rigid body] is turned on in the [Character information] palette.

(1) Add rigid body
If no rigid body has been created for the bone selected in [Target bone], you can create a rigid body for that bone.

A rigid body cannot be added for a bone that already has a rigid body.

(2) Delete rigid body
Deletes the rigid body of the bone selected in [Target bone].

Please note that rigid bodies and joints affect other settings. This means that your character may still not move as 
expected when the settings are changed, or the movement of the rigid body or joint may be affected by the set-
tings of another rigid body.

The squares between rigid bodies are joints.
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(3) Name
The name of the rigid body. Usually displays the name of the bone associated with the rigid body. Click this field to input a name.

(4) Type
Select the type of rigid body.

(5) Shape
Select the shape of the rigid body. Three rigid body shapes are available: [Sphere], [Cube] and [Capsule].

(6) Center
Adjust the position of the rigid body. Click the numeric value to input a value.

(7) Orientation
Adjust the angle of the rigid body. Click the numeric value to input a value.

(8) Size
Adjust the size of the rigid body. Click the numeric value to input a value.

(9) Mass
Set the mass of the rigid body. Click this field to input a numeric value. When [Physics operation] or [Match bone position] causes a colli-
sion between multiple rigid bodies, the rigid body with the lower mass is affected more strongly.

(10)Movement damping
Creates a slight delay in movement speed when a rigid body moves. Click this field to input a numeric value. A value from 0 to 1 can be 
input. The larger the value, the smaller the movement and the shorter the movement time will be.

(11) Rotation damping
Creates a slight delay in rotation speed when a rigid body moves. Click this field to input a numeric value. A value from 0 to 1 can be 
input. The larger the value, the smaller the movement and the shorter the movement time will be.

(12)Repelling force

Bone emulation
The rigid body moves to emulate the associated bone. The rigid body does not move when it 
collides with another rigid body.

Physics operation The rigid body moves freely within the limited range configured in the joint settings.

Match bone position

The rigid body moves when force is applied, such as when it collides with another rigid body. 
When a strong force is applied and the rigid body is about to move outside the movement range of 
the bone, the position of the rigid body is automatically corrected to stay within the bone's 
movement range.

Sphere Box

Capsule
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Set how strongly the rigid body rebounds when it comes into contact with other rigid bodies. Click this field to input a numeric value. The 
larger the value, the more strongly the rigid body rebounds.

(13)Friction force
Set the resistance created by friction when the rigid body rubs against another rigid body. Click this field to input a numeric value. The 
higher the value, the greater the resistance created by friction and the slower the movement will be.

(14)Group
Set groups of rigid bodies. Select a number from the pull down menu.

Dividing rigid bodies into groups makes it possible to add effects such as adjustments without causing collisions between particular rigid 
bodies. Multiple rigid bodies (bones) can be set together in a group.

(15)Non-collision group
Set a group that you do not want to collide with the selected group.

(16)Add rigid bodies to standard bones
Adds multiple rigid bodies and joints to the bones within a part.

For example, if [Physics settings] is selected in a [Body parts folder] in the [Character configuration] palette, rigid bodies and joints are set 
for all bones in that body part.

(17)Delete
Deletes multiple rigid bodies and joints from the bones within a part.

For example, if [Physics settings] is selected in a [Body parts folder] in the [Character configuration] palette, all rigid bodies and joints in 
that body part are deleted.
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Joints
The following settings are displayed when [Joint] is turned on in the [Character information] palette.

(1) Joint
If the bone (rigid body) selected in [Target bone] has multiple joints, select the joint for which you want to configure the settings.

(2) Add joint
Add a joint to a character. Select a rigid body as the [Connection origin] and a rigid body as the [Connection destination] and click [Add 
joint] to create a joint.

(3) Delete joint
Deletes the joint selected in [Joint].

(4) Name
Set a name for the joint. Click this field to input a joint name.

(5) Rigid body as connection origin
Set a rigid body as the connection origin. Select a rigid body name from the pull down menu.

(6) Rigid body as connection destination 
Set a rigid body as the connection destination. Select a rigid body name from the pull down menu.

(7) Center
Adjust the position of the joint. Click the numeric value to input a value.

(8) Orientation
Adjust the orientation of the joint. Click the numeric value to input a value.

The [Rotation limit] is based on the numeric value input for [Orientation].

Please note that rigid bodies and joints affect other settings. This means that your character may still not move as 
expected when the settings are changed, or the movement of the rigid body or joint may be affected by the set-
tings of another rigid body.
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(9) Movement limit
Set a movement limit for the joint. Click the numeric value to input a value. A [Max] and [Min] can be set.

(10)Rotation limit
Set a rotation limit for the joint. Click the numeric value to input a value. A [Max] and [Min] can be set.

(11) Spring
Add spring force to the joint.

(12)Add rigid bodies to standard bones
Adds multiple rigid bodies and joints to the bones within a part.

For example, if [Physics settings] is selected in a [Body parts folder] in the [Character configuration] palette, rigid bodies and joints are set 
for all bones in that body part.

(13)Delete
Deletes multiple rigid bodies and joints from the bones within a part.

For example, if [Physics settings] is selected in a [Body parts folder] in the [Character configuration] palette, all rigid bodies and joints in 
that body part are deleted.

When a shape is selected
When a [Shape] belonging to a 3D model is selected on the [Character configuration] palette, the shape settings are displayed.

The displayed shape settings vary depending on the imported model. Drag the sliders to apply the shape settings to the 3D character in the 
[Document] window.

When a pose is selected
The following settings can be configured in the [Character information] palette when a [Pose] in the [Character configuration] palette is 
selected.

Move Set the force with which the joint returns when the spring is pulled. Click this field to input a numeric value.

Rotate Set the force with which the joint returns when the spring is rotated. Click this field to input a numeric value.

Operations for shapes can be performed in CLIP STUDIO MODELER, but not in CLIP STUDIO PAINT.

Operations for poses can be performed in CLIP STUDIO MODELER, but not in CLIP STUDIO PAINT.
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(1) Thumbnail
The thumbnail of the [Pose]. Click the thumbnail to display the [Capture thumbnail] window where a thumbnail can be captured for the 
pose. For information on how to configure this, see "Capturing a Thumbnail" .

(2) Name
Displays the name of the edited pose. Double clicking the field allows you to enter a pose name. The input name is applied to the [Charac-
ter configuration] palette.

(3) Comment
A comment about the [Pose] can be set. Right click the item name to input text. Information such as a description of the [Pose] can be 
entered here.

(4) Apply pose to character
Apply a [Pose] selected in the [Character configuration] palette to a 3D character in the [Document] window.

(5) Save character pose
Saves the pose of the character in the [Document] window to a [Pose] selected in the [Character configuration] palette.

Menu of the Character Information Palette
This section describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the [Char-
acter information] palette.

Hide Character Information Palette
Hides the [Character information] palette.

To display the [Character information] palette again, select [Window] menu → [Character information].
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Default Bone Mapping 
Mode
Default bone mapping mode is a settings screen for assigning default bones to 3D characters that use other 
bones. This section describes the following items in default bone mapping mode.

 About Default Bone Mapping Mode

 Setting Default Bone Mapping
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Default Bone Mapping Mode

 About Default Bone Mapping Mode
The default bone mapping settings mode can be displayed by selecting a [Body parts folder] in the [Character configu-
ration] palette and clicking [Default bone mapping] in the [Character information] palette.

This assigns default bones that can be used in CLIP STUDIO products to 3D characters that use other bones. The 3D
characters can be used in CLIP STUDIO PAINT after the default bones are assigned.

The default bone mapping settings mode is divided into the following main areas.

A. Navigation area
Displays settings for default bone mapping. The settings vary depending on the setting procedure.

B. Preview area
A screen for setting and checking default bone mapping.

(1) Guide model
Default bone mapping is set according to this model's bones.

(2) 3D character
The 3D character for which default bone mapping is set.

A

B
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 Setting Default Bone Mapping
After importing a 3D file in CLIP STUDIO MODELER, display the default bone mapping mode and set default bones.

1 Select a body part
Select a [Body parts folder] from the [Character configuration] palette.

(1) Select [Body] from the group on the [Character configuration] palette.

(2) Select the body parts folder to be edited from the [List].

2 Display default bone mapping mode
Click [Default bone mapping] in the [Character information] palette.

For information on importing a 3D file as a [Body], see "Importing 3D Materials" →"Full-body Character Data" .

A message saying "You will no longer be able to edit the position, orientation or scale after performing this oper-
ation." is displayed. If you do not need to configure these settings further, click [OK]. The position, orientation 
and scale can be edited by configuring the settings in the [Character information] palette when the body part is 
selected. For details, see "Setting 3D Character Information" .
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3 Adjust the angle of the arms to match the 3D character
Configure this setting while the default bone mapping mode is displayed.

(1) Drag the slider to change the angle of the guide model's arms. Set the angle of the guide model's arms to match the arms of the 3D 
character.

(2) Click [Next].

4 Assign the bones
Assign the default bones as the 3D character's bones.

(1) Check the pink areas of the guide model's bones. These are the bone positions that will be specified for the 3D character.

(2) Click the bones of the 3D character to specify the bones.
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(3) The 3D character's head bones are specified and turn pink.

(4) The pink area of the guide model's bones switches to the next position to be specified.

(5) Repeat step (1), clicking the bones of the 3D character to specify the bones.

5 Finish assigning the bones
When you have finished assigning all of the bones, click [Next].

 For models where the head cannot be specified, such as models used for body parts, click [Select neck]. The 
neck position is specified in place of the head.

 If bones are specified incorrectly on the 3D character, click the button in the [Navigation area] for the area 
where the mistake occurred. This allows you to specify the bones again.
CLIP STUDIO MODELER USER GUIDE 168



Default Bone Mapping Mode > Setting Default Bone Mapping
6 Check the mapping results
Check the default bone mapping results.

(1) Click the pose icons.

(2) Check that the pose of the 3D character is the same as the guide model.

 A different pose is assigned to each pose icon.

 It may not be possible to recreate the poses in 3D characters with an extremely different body, such as ani-
mals.

 The camera orientation can be changed by dragging in the [Preview area]. This makes it possible to check the 
3D character from various angles.
CLIP STUDIO MODELER USER GUIDE 169



Default Bone Mapping Mode > Setting Default Bone Mapping
7 Exit the settings mode
Click [Complete] in the [Navigation area].

This exits the default bone mapping settings mode and returns to the 3D Character Setup screen. Default bones are assigned to the 3D 
character.

To redo the settings, click [Return] to return to the previous screen.
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Standard Bone Creation 
Mode
Standard bone creation mode is a settings screen for adding standard bones to 3D characters that do not have 
bones. This section describes the following items in standard bone creation mode.

 About Standard Bone Creation Mode

 Creating Standard Bones
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Standard Bone Creation Mode

 About Standard Bone Creation Mode
The standard bone creation screen can be displayed by selecting a [Body parts folder] in the [Character configuration]
palette and clicking [Create standard bone] in the [Character information] palette.

This creates standard bones that can be used with CLIP STUDIO products for 3D characters that do not have bones.
The 3D characters can be used in CLIP STUDIO PAINT after the bones are created.

A. Navigation area
Displays settings for standard bone creation. The settings vary depending on the setting procedure.

B. Preview area
A screen for setting and checking standard bone creation.

A B
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 Creating Standard Bones
After importing a 3D file in CLIP STUDIO MODELER, display standard bone creation mode and set standard bones.

1 Select a body part
Select a [Body parts folder] from the [Character configuration] palette.

(1) Select [Body] from the group on the [Character configuration] palette.

(2) Select the [Body parts folder] to be edited from the [List].

2 Display standard bone creation mode
Click [Create standard bones] in the [Character information] palette.

Next, proceed to "Set the bone position" .

For information on importing a 3D file as a body part, see "Importing 3D Materials" →"Full-body Character Data" .
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Set the bone position
Set the position of the [Hips], [Head], [Arms] and [Legs] zones.

Set the hip bone and model position
When the hip bone is displayed in the [Preview area], align it with the hip area of the 3D character.

1 Select the hip bone
Click the hip bone displayed in the [Preview area].

2 Adjust the height of the hip bone
When the manipulator is displayed over the bone, drag the arrows with the mouse cursor.

Match the height of the bone with the height of the 3D character's hips.
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3 Adjust the position of the 3D character
Align the position of the 3D character with the bone.

(1) Click the 3D character.

(2) When the manipulator is displayed at the character's feet, drag the blue arrows with the mouse cursor. Align the position of the 3D 
character with the bone.

Next, proceed to "Set the head bone position" .

Set the head bone position
Set the head and neck bones of the 3D character.

1 Change the bone settings
Click [Set head bone position] in the [Navigation area].

The [Preview area] switches to the screen for setting the head bone.

For information on how to change the camera angle in the [Preview area], see "Setting Camera Angles" .

To return to the hip settings, click [Set hip bone and model position] in the [Navigation area].
Clicking [Cancel] clears all of the settings configured so far.
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2 Set the bone position
Align the position of the bone with the 3D character.

(1) Click the lower bone in the [Preview area].

(2) A manipulator is displayed. Drag the arrows of the manipulator with the mouse cursor to move the entire bone.

(3) Align the position of the bone with the model. The bottom of the center bone should be aligned with the base of the neck.

3 Set the length of the neck
Set the correct neck bone length for the 3D character.

(1) Click the center bone in the [Preview area].

(2) When the manipulator is displayed over the bone, drag the arrows with the mouse cursor. Match the height of the bone with the 3D 
character's neck.

For information on how to change the camera angle in the [Preview area], see "Setting Camera Angles" .
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4 Set the length of the head
Set the correct head bone length for the 3D character.

(1) Click the upper bone in the [Preview area].

(2) When the manipulator is displayed over the bone, drag the arrows with the mouse cursor. Match the height of the bone with the 3D 
character's head.

5 Check the position of the bones
Change the camera angle and check the position of the bones from various angles.

If any corrections are needed, readjust the bone positions in the [Preview area].

Next, proceed to "Set the arm bone position" .
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Set the arm bone position
Set the arm bones of the 3D character.

1 Change the bone settings
Click [Set arm bone position] in the [Navigation area].

The [Preview area] switches to the screen for setting the arm bones.

2 Set the bone position
Align the position of the bone with the 3D character.

(1) Click the bone at the base of the arm in the [Preview area].

(2) When the manipulator is displayed over the bone, drag the arrows with the mouse cursor. Set the bones so that the tops are in the same 
position as the base of the 3D character's arms.

To return to the [Hips] or [Head] settings, click [Set bone and model position] or[Set head bone position] in the 
[Navigation area].
Clicking [Cancel] clears all of the settings configured so far.

When you set the bones of one arm, the setting is applied to the other arm at the same time.
CLIP STUDIO MODELER USER GUIDE 178



Standard Bone Creation Mode > Creating Standard Bones > Set the bone position
3 Set the bone angle
Match the angle of the bone with the 3D character.

(1) Click the upper arm bone in the [Preview area].

(2) A manipulator is displayed. Drag the ring of the manipulator with the mouse cursor to change the angle of the bone. Match the angle 
of the bone with the 3D character.

4 Set the length of the bones
Drag the arrow of the manipulator with the mouse cursor. Align the end of the bone with the elbow of the 3D character.

5 Check the position of the bones
Change the camera angle and check the position of the bones from various angles.

If any corrections are needed, readjust the bone positions in the [Preview area].

Next, proceed to "Set the leg bone position" .

For information on how to change the camera angle in the [Preview area], see "Setting Camera Angles" .

If the manipulator is not displayed, click the upper arm bone to display it.

Drag along the ring to change the angle of the bone.
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Set the leg bone position
Set the leg bones of the 3D character.

1 Change the bone settings
Click [Set leg bone position] in the [Navigation area].

The [Preview area] switches to the screen for setting the leg bones.

2 Set the bone position
Align the position of the bone with the 3D character.

(1) Click the bone at the base of the leg in the [Preview area].

(2) A manipulator is displayed. Drag the arrow of the manipulator with the mouse cursor and align the position of the bones with the 3D 
character.

To return to the [Hips], [Head] or [Arm] settings, click [Set hip bone and model position], [Set head bone position] 
or [Set arm bone position] in the [Navigation area].
Clicking [Cancel] clears all of the settings configured so far.

When you set the bones of one leg, the setting is applied to the other leg at the same time.
CLIP STUDIO MODELER USER GUIDE 180



Standard Bone Creation Mode > Creating Standard Bones > Set the bone position
3 Set the bone angle
Match the angle of the bone with the 3D character.

(1) Click the thigh bone in the [Preview area].

(2) A manipulator is displayed. Drag the ring of the manipulator with the mouse cursor to change the angle of the bone. Match the angle 
of the bone with the 3D character.

4 Set the length of the bones
Use the manipulator of the thigh bone to match the length of the thigh bone with the 3D character.

(1) Drag the arrows of the manipulator with the mouse cursor to change the length of the bone.

(2) Align the bottom of the bone with the knee of the 3D character.

If the manipulator is not displayed, click the leg bone to display it.

Drag along the ring to change the angle of the bone.
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5 Adjust the shin bones
Set the angle and length of the shins.

(1) Click the shin bone in the [Preview area].

(2) A manipulator is displayed. Drag the manipulator with the mouse cursor to change the angle and length of the bone. Align the bottom 
of the bone with the ankle of the 3D character.  

6 Adjust the foot bones
Set the angle and length of the feet.

(1) Click the foot bone in the [Preview area].  

(2) A manipulator is displayed. Drag the manipulator with the mouse cursor to change the angle and length of the bone. Match the bone 
with the foot shape of the 3D character.
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7 Adjust the toe bones
Set the length of the toes.

(1) Click the toe bone in the [Preview area].

(2) A manipulator is displayed. Drag the manipulator with the mouse cursor to change the length of the bone. Align the end of the bone 
with the end of the 3D character's toes.

8 Check the position of the bones
Change the camera angle and check the position of the bones from various angles.

If any corrections are needed, readjust the bone positions in the [Preview area].

9 Exit the bone settings mode
Click [Next] in the [Navigation area].

The display switches to the screen for setting the position of the fingers. Next, proceed to "Set the finger position" .
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Set the finger position
Specify the finger position of the 3D character and set the finger bones.

1 Select a finger
Select the finger to be specified in the [Navigation area]. In this example, [Thumb] is selected.

2 Change the camera position
Operate the camera in the [Preview area] to zoom in on the finger.

For information on how to operate the camera, see "Setting Camera Angles" .

When zooming in on the hand, zoom in with the fingers open and parallel, as this makes it easy to specify finger 
positions.
CLIP STUDIO MODELER USER GUIDE 184



Standard Bone Creation Mode > Creating Standard Bones > Set the finger position
3 Specify the finger position
Drag to specify the finger position.

(1) Drag to surround the thumb of the 3D character in the [Preview area].

(2) The specified area for the finger is colored. In the case of the thumb, the area turns red. If part of the thumb is not specified, drag 
again to surround the whole thumb.

(3) If the area is too large, hold down the [Shift] key and drag to surround the area you want to remove.
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(4) The dragged area is removed from the specified area.

4 Specify the next finger.
Repeat the operations in steps 2 and 3 for all of the fingers.

(1) Select the next finger to be specified in the [Navigation area]. In this example, [Index finger] is selected.

(2) Repeat the operations in step 3 to specify the position of the finger.

 If it is difficult to specify the finger while the hand is lying flat, adjust the camera angle to a position where it is 
easier to specify the finger.

 When a finger position is set for one hand, the position is set for the other hand too.
CLIP STUDIO MODELER USER GUIDE 186



Standard Bone Creation Mode > Creating Standard Bones > Set the finger position
(3) Repeat the operations in steps 1 and 2 to specify the positions of all of the fingers.

5 Check the settings
Change the camera angle and check the finger settings from various angles.

If any corrections are needed, specify the positions again in the [Preview area].

6 Exit the finger position settings mode
Click [Next] in the [Navigation area].

A screen for checking the bones is displayed. Next, proceed to "Check the bones" .

To correct a finger specification, select the button for the finger you want to correct in the [Navigation area]. Set 
the selected finger again.
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Check the bones
When the screen for checking the bones is displayed, check the movement of the bones in the [Preview area].

1 Check the movement of the bones
Check the movement of the bones in the [Preview area].

For information on how to operate the bones, see "Creating a Pose" .

2 Exit the settings mode
Click [Complete] in the [Navigation area].

To redo the settings, click [Return] to return to the previous screen.
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This exits the standard bone creation settings mode and returns to the 3D Character Setup screen. Standard bones are created for the 3D 
character.
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Skirt Settings Mode
Skirt settings mode is a settings screen to make natural skirt movements. This section describes the following 
items in skirt settings mode.

 About Skirt Settings Mode

 Configuring Skirt Settings
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Skirt Settings Mode

 About Skirt Settings Mode
Skirt settings mode can be displayed by selecting a [Body parts folder] in the [Character configuration] palette and
clicking [Skirt settings] in the [Character information] palette. In this mode, you can set a skirt net for a 3D character.

Set the outer skirt net. Setting a skirt net enables the skirt to move naturally with the body when applying a pose.

The skirt settings mode is divided into the following main areas.

A. Navigation area
Displays skirt settings. The settings vary depending on the setting procedure.

B. Preview area
A screen for checking the settings. The direction from which the skirt being edited is viewed can be changed by dragging in the [Preview 
area]. Like the [Document] window, this screen has world coordinate axes.

When the skirt settings are configured, 

the skirt moves according to the movement of the legs.

A

B
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 Configuring Skirt Settings
The skirt settings mode will be explained with the following steps.

 "Display skirt settings mode" 

 "Select the material" 

 "Set the skirt net" 

 "Set the collision shape" 

Display skirt settings mode
Display skirt settings mode from the 3D Character Setup screen.

1 Select a body part
Select a [Body parts folder] from the [Character configuration] palette.

(1) Select [Body] from the group on the [Character configuration] palette.

(2) Select the [Body parts folder] to be edited from the [List].

2 Display skirt settings mode
Click [Skirt settings] in the [Character information] palette.

For information on importing a 3D file as a body part, see "Importing 3D Materials" →"Full-body Character Data" .
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Skirt settings mode is displayed.

Next, proceed to "Select the material" .

A message saying "You will no longer be able to edit the position, orientation or scale after performing this oper-
ation." is displayed. If you do not need to configure these settings further, click [OK]. The position, orientation 
and scale can be edited by configuring the settings in the [Character information] palette when the body part is 
selected. For details, see "When a part is selected"  → "Body parts folders" .
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Select the material
Select the skirt material from the [Material list] in the [Navigation area].

1 Select the skirt material
Select the materials so that only the skirt material is shown in the [Preview area].

(1) Check the check box for the skirt material. Parts indicated by the checked materials are displayed in the [Preview area].

(2) Uncheck the check boxes for the other materials. Parts indicated by the unchecked materials are not displayed in the [Preview area].

(3) Make sure only the skirt is displayed in the [Preview area]. If the skirt is combined with other items, select the materials so that only 
the material containing the skirt is displayed.

If there is a large number of materials, you can display or hide all materials by selecting [Select all] or [Deselect 
all] in the [Navigation area].
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2 Exit the material selection mode
After selecting a skirt material, click [Next] in the [Preview area].

The next screen is displayed, allowing you to proceed to "Set the skirt net" .

Set the skirt net
When the skirt net is displayed in the [Preview area], align the net with the skirt.

Skirt net
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1 Set the top position of the skirt net
Set the position and size of the top of the skirt net in the [Navigation area].

Set the top of the skirt net according to the position and size of the top of the skirt.

(1) Select [Top of skirt] from the settings in the [Navigation area].

(2) Set the position of the top of the skirt net by adjusting the [x], [y] and [z] sliders.

(3) Set the size of the top of the skirt net by adjusting the [Width], [Depth] and [Tilt] sliders.

 For information on how to change the camera angle in the [Preview area], see "Setting Camera Angles" .

 The order of steps (2) and (3) can be reversed.

 If the material includes items other than the skirt, align the skirt net with the area corresponding to the skirt 
(e.g. from the hips to the hem of the skirt).
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2 Set the bottom position of the skirt net
Set the position and size of the bottom of the skirt net in the [Navigation area].

Set the bottom of the skirt net according to the position and size of the bottom of the skirt.

(1) Select [Bottom of skirt] from the settings in the [Navigation area].

(2) Set the position of the bottom of the skirt net by adjusting the [x], [y] and [z] sliders.

(3) Set the size of the bottom of the skirt net by adjusting the [Width], [Depth] and [Tilt] sliders.

3 Check the position of the skirt net
Change the camera angle and check the position of the skirt net from various angles.

If any corrections are needed, readjust the skirt net in the [Navigation area].

 For information on how to change the camera angle in the [Preview area], see "Setting Camera Angles" .

 The order of steps (2) and (3) can be reversed.
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4 Move to the next screen
When you have finished setting the skirt net, click [Next] in the [Navigation area].

The next screen is displayed, allowing you to proceed to "Set the collision shape" .

Skirt net settings
This section explains the skirt net settings in the [Navigation area].

The settings are configured according to the axes at the character's feet.

(1) Settings
Select the position of the skirt net to be set. You can select from [Top of skirt] and [Bottom of skirt] by default.

(2) Add setting
Adds [Middle of skirt] to the skirt net settings. This makes it possible to set the middle of the skirt net too.

This is useful for long or fluttery skirts.

(3) x 
Moves the position of the skirt net along the red world coordinate axis.

(4) y
Moves the position of the skirt net along the green world coordinate axis.

For information on settings in the [Navigation area], see "Skirt net settings" .
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(5) z
Moves the position of the skirt net along the blue world coordinate axis.

(6) Width
Adjusts the width of the skirt net along the red world coordinate axis.

(7) Depth
Adjusts the depth of the skirt net along the blue world coordinate axis.

(8) Tilt
Tilts the skirt net along the green world coordinate axis.

Set the collision shape
The collision shape is displayed along the character's hips and legs in the [Preview area]. Adjust the position and size of the collision shape to 
set the movement of the skirt.

Collision shape
CLIP STUDIO MODELER USER GUIDE 199



Skirt Settings Mode > Configuring Skirt Settings > Set the collision shape
1 Select the collision shape of the hip area
Click the collision shape of the hip area in the [Preview area]. The [Part] name changes in the [Navigation area].

2 Set the collision shape of the hips
Set the collision shape according to the shape of the hips.

(1) Set the [z] value for [Rotate] to "90".

(2) Set the position of the collision shape by adjusting the [x], [y] and [z] sliders for [Position].

(3) Set the width of the collision shape by adjusting the [Width] slider.

(4) Set the length of the collision shape by adjusting the [Length] slider.

The collision shape can also be selected by clicking the collision shape you want to set in the [Preview area].

 For information on how to change the camera angle in the [Preview area], see "Setting Camera Angles" .

 To change the [Position] after setting the [Position], [Width] and [Height], use each slider to set these values.
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3 Select the collision shape of the thigh area
Click the collision shape of the thigh area in the [Preview area]. The [Part] name changes in the [Navigation area].

4 Set the collision shape of the thigh area
Set the collision shape according to the shape of the thighs.

(1) Check that [Edit left-right symmetry] is turned on. Enabling this means that when you set one leg, the setting is applied to the other 
leg at the same time.

(2) Set [Position], [Rotate], [Width] and [Length] according to the shape of the thighs.
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5 Select the collision shape of the shin area
Click the collision shape of the shin area in the [Preview area]. The [Part] name changes in the [Navigation area].

6 Set the collision shape of the shins
Set the collision shape according to the shape of the shins.

(1) Check that [Edit left-right symmetry] is turned on. Enabling this means that when you set one leg, the setting is applied to the other 
leg at the same time.

(2) Set [Position], [Rotate], [Width] and [Length] according to the shape of the shins.
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7 Check the movement of the skirt
Drag the legs of the character and check the movement of the skirt.

8 Exit the settings mode
Click [Complete] in the [Navigation area].

This exits the skirt settings mode and returns to the 3D Character Setup screen.

 To redo the settings, click [Return] to return to the previous screen.

 For information on these settings, see "Collision shape settings" .

The collision shape created in the skirt settings mode cannot be displayed in the 3D Character Setup screen.
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Skirt Settings Mode > Configuring Skirt Settings > Set the collision shape
Collision shape settings
This section explains the collision shape settings in the [Navigation area].

(1) Part
Click this to display a list of parts. Select the part you want to set. The collision shape for the selected part is displayed in red in the [Pre-
view area]. When a part is clicked in the [Preview area], the name of the clicked part is displayed in [Part].

A collision shape can only be set for the hips, thighs and shins.

(2) Position
Adjust the position of the collision shape using the sliders.

(3) Rotate
Adjust the angle of the collision shape using the sliders.

(4) Width
Set the diameter of the collision shape to change the width. Click this field to input a numeric value.

(5) Height
Set the distance between the centers of the two spheres of the capsule to set the height of the collision shape. Click this field to input a 
numeric value.

(6) Edit left-right symmetry
When this is turned on, when one side of a collision shape with left-right symmetry is set, the same settings are applied to the other side.

x Move the position of the collision shape up or down.

y Move the position of the collision shape left or right.

z Move the position of the collision shape forward or back.

x Rotate the collision shape around the up-down axis.

y Rotate the collision shape around the left-right axis.

z Rotate the collision shape around the front-back axis.
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Common Features
The Common Features section explains items used in all screens of CLIP STUDIO MODELER.

 Tool-type Palettes

 Navigator Palette

 Camera Settings Palette

 View Settings Palette

 Material Palette

 Menu

 Shortcut List



Tool-type Palettes
This section explains the functions of tool-type palettes in CLIP STUDIO MODELER.

 About Tool-type Palettes

 Tool Palette

 Sub Tool Palette

 Tool Property Palette



Tool-type Palettes > About Tool-type Palettes > How to use tool-type palettes
Tool-type Palettes

 About Tool-type Palettes
The following tool-type palettes are used in CLIP STUDIO MODELER.

 "Tool Palette" 

 "Sub Tool Palette" 

 "Tool Property Palette" 

How to use tool-type palettes
To use a tool-type palette, proceed as follows.

1 Select the tool
On the [Tool] palette, select the tool to use.

2 Select the sub tool
On the [Sub tool] palette, select the sub tool for the intended purpose.

3 Adjust the sub tool settings
On the [Tool Property] palette, adjust the settings of the currently selected sub tool.

4 Tool setup complete
The tool setup is complete. The tool is now configured for the intended purpose.
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Tool-type Palettes > Tool Palette > Tool palette menu
 Tool Palette
The [Tool] palette displays when [Window] menu → [Tool] is selected. Various tools are arranged as buttons. Clicking
a button enables the tool for use.

(1) Tool buttons
Various tools are arranged as buttons. Clicking a button enables the tool for use.

Note that a tool button is displayed with the icon of the selected sub tool.

Tool palette menu
The following describes the functions included in the menu that displays when you click [Palette menu] on the upper left corner of the [Tool] 
palette.

Hide Tool palette
Hides the [Tool] palette.

Different tools are displayed in the [Tool] palette in the 3D Object Setup screen and material setup screens.

 For information on tools in the 3D Object Setup screen, see "Tool List (3D Object Setup Screen)" .

 For information on tools in the 3D Character Setup screen, see "Tool List (3D Character Setup Screen)" .

To display the [Tool] palette again, select [Window] menu → [Tool].

Show Menu
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Tool-type Palettes > Sub Tool Palette > Sub Tool palette menu
 Sub Tool Palette
The [Sub tool] palette displays when [Window] menu → [Sub tool] is selected. Each tool comes with preconfigured set-
tings called [Sub tool].

A sub tool is assigned to each button in the [Sub Tool] palette. Click to change the [Tool Property] palette settings. For
some tools, [Switch group] can be clicked to display another group of sub tools.

Sub Tool palette menu
The following describes the functions included in the menu that displays when you click [Palette menu] on the upper left corner of the [Sub 
tool] palette.

Hide Sub Tool palette
Hides the [Sub tool] palette.

The [Sub Tool] settings differ depending on the selected tool.

To display the [Sub Tool] palette again, select [Window] menu → [Sub Tool].

Sub Tool

Switch group

Show Menu
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Tool-type Palettes > Tool Property Palette > Tool Property palette menu
 Tool Property Palette
The [Tool Property] palette displays when [Window] menu → [Tool Property] is selected. The [Tool Property] palette
adjusts the settings of the selected sub tool.

(1) Selected sub tool
Displays the name of the sub tool selected on the [Sub Tool] palette.

(2) Tool Property
Allows you to adjust the settings of the sub tool selected on the [Sub tool] palette.

Tool Property palette menu
The following describes the functions included in the menu that displays when you click [Palette menu] on the upper left corner of the [Tool 
Property] palette.

Hide Tool Property palette
Hides the [Tool Property] palette.

The [Tool Property] settings differ depending on the selected sub tool.

To display the [Tool Property] palette again, select [Window] menu → [Tool Property].

Show Menu
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Navigator Palette
The [Navigator] palette is used to adjust the camera angle by dragging the rectangle on the palette.
You can also change the camera distance and switch the projection method and perspective using the icons 
and sliders on the palette.
The [Navigator] palette is displayed when the [Window] menu → [Navigator] is selected.

 Functions of the Navigator Palette



Navigator Palette > Functions of the Navigator Palette
Navigator Palette

 Functions of the Navigator Palette
This section describes the functions and names of each part of the [Navigator] palette.

A. Navigator controls
The orientation of the camera can be changed by clicking the mouse buttons and dragging the rectangular area.

The orientation of the camera changes based on the direction in which the rectangular area is dragged and the combination of mouse but-
tons clicked.

Changing the x axis orientation of the camera
Left click and drag the rectangular area up or down to change the x axis orientation of the camera.

Changing the y axis orientation of the camera
Left click and drag the rectangular area left or right to change the y axis orientation of the camera.

Changing the z axis orientation of the camera
Right click and drag the rectangular area to change the z axis orientation of the camera.

Click the circle where the x axis (vertical line) and y axis (horizontal line) meet in [Navigator controls] to move the 
camera position. The center of the circle indicates the camera position.

A

B

C

D

E F G H I

The orientation of the camera can be changed by dragging the mouse.

The orientation of the camera changes based on the direction 

in which the mouse is dragged and the combination of mouse buttons clicked.
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Navigator Palette > Functions of the Navigator Palette
B. Change perspective
Clicking this icon changes the display in the [Document] window to orthographic projection.

C. Distance
Set the distance of the camera. Moving the slider to the right moves the camera further away.

D. Perspective projection/Parallel projection
Switch the display of the [Document] window between perspective projection and parallel projection.
 When off, parallel projection is used for the display in the [Document] window.
 When on, perspective projection is used for the display in the [Document] window. Switching to perspective projection makes it pos-

sible to adjust the viewing angle using the sliders to the right of the icon.

E. Undo point of view
Undoes changes to the perspective.

F. Redo point of view
Redoes undone changes to the perspective.

G. Show all 3D items
Adjusts the perspective so that all meshes and characters are displayed.

H. Set as center of camera
Adjusts the camera position so that the selected area is displayed at the center. If no area is selected, the camera position is adjusted to cen-
ter all mesh objects.

I. Reset camera
Restores the settings of the camera to the default.

(1) Front view Changes the camera perspective to a front view.

(2) Back view Changes the camera perspective to a back view.

(3) Left view Changes the camera perspective to a left view.

(4) Right view Changes the camera perspective to a right view.

(5) Top view Changes the camera perspective to a top view.

(6) Bottom view Changes the camera perspective to a bottom view.

The camera orientation does not change.
CLIP STUDIO MODELER USER GUIDE 213



Navigator Palette > Functions of the Navigator Palette > Navigator palette menu
Navigator palette menu
This section describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the [Navi-
gator] palette.

Hide Navigator palette
Hides the [Navigator] palette.

To display the [Navigator] palette again, select [Window] menu → [Navigator].

Show Menu
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Camera Settings Palette
The [Camera settings] palette is used to change the camera angle and distance and switch the projection 
method and perspective.
The [Camera settings] palette is displayed when the [Window] menu → [Camera settings] is selected.

 Functions of the Camera Settings Palette



Camera Settings Palette > Functions of the Camera Settings Palette
Camera Settings Palette

 Functions of the Camera Settings Palette
This section describes the functions and names of each part of the [Camera settings] palette.

A. x axis rotation
Set the rotation of the x axis of the camera.

B. y axis rotation
Set the rotation of the y axis of the camera.

C. z axis rotation
Set the rotation of the z axis of the camera.

D. Change perspective
Clicking this icon changes the display in the [Document] window to orthographic projection.

E. Camera distance
Set the distance of the camera. Moving the slider to the right moves the camera further away.

F. Perspective projection/Parallel projection
Switch the display of the [Document] window between perspective projection and parallel projection.
 When off, parallel projection is used for the display in the [Document] window.
 When on, perspective projection is used for the display in the [Document] window. Switching to perspective projection makes it pos-

sible to adjust the viewing angle using the sliders to the right of the icon.

(1) Front view Changes the camera perspective to a front view.

(2) Back view Changes the camera perspective to a back view.

(3) Left view Changes the camera perspective to a left view.

(4) Right view Changes the camera perspective to a right view.

(5) Top view Changes the camera perspective to a top view.

(6) Bottom view Changes the camera perspective to a bottom view.
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Camera Settings Palette > Functions of the Camera Settings Palette > Camera settings palette menu
G. Undo point of view
Undoes changes to the perspective.

H. Redo point of view
Redoes undone changes to the perspective.

I. Show all 3D items
Adjusts the perspective so that all meshes and characters are displayed.

J. Set as center of camera
Adjusts the camera position so that the selected area is displayed at the center. If no area is selected, the camera position is adjusted to cen-
ter all mesh objects.

K. Reset camera
Restores the settings of the camera to the default.

Camera settings palette menu
This section describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the [Cam-
era settings] palette.

Hide Camera settings palette
Hides the [Camera settings] palette.

The camera orientation does not change.

To display the [Camera settings] palette again, select [Window] menu → [Camera settings].

Show Menu
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View Settings Palette
The [View Settings] palette can be used to configure display settings such as mesh, grids and coordinates.
The [View Settings] palette is displayed when the [Window] menu → [View Settings] is selected.

 Functions of the View Settings Palette



View Settings Palette > Functions of the View Settings Palette
View Settings Palette

 Functions of the View Settings Palette
This section describes the functions and names of each part of the [View Settings] palette.

A. Grid
Set how to show grids.

(1) Style
Set how to show grids.

(2) Grid size
Set the size of each square in the grid.

(3) Grid number
Set the number of squares in the grid. Input the number of squares to be created in each row of a plane.

(4) Absorption range
Use the [Move] tool to set the area to be absorbed by the grid when the mesh or an element is moved. The area of the mesh or elements 
indicated by [Absorption range] is absorbed by each square.

Cube and one plane Displays a grid on one plane. This cannot be set in the material setup screen.

Cube and three planes Displays a grid on three planes. This cannot be set in the material setup screen.

1plane Displays a grid on only one plane. The grid is not displayed.

None No grid is displayed.

In the quad screen view, the [Style] setting is applied only to the perspective view.

In the Edit 3D Shape screen, these are absorbed by the grid during movement when [Grid snap] is turned on in the 
[Tool Property] palette of the [Move] tool.

A
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View Settings Palette > Functions of the View Settings Palette > View Settings palette menu
B. Enabled
Set how to show meshes and 3D models.

C. Drawing effects
Set drawing effects for 3D models in the material setup screen. This cannot be set in the Edit 3D Shape screen.

D. Shader
Set the shading method for 3D models in the material setup screen. This cannot be set in the Edit 3D Shape screen.

Select from [Flat shading], [Gouraud shading], [Phong shading] and [Toon shading].

View Settings palette menu
This section describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the [View 
Settings] palette.

Hide View Settings palette
Hides the [View Settings] palette.

Lighting Enables lighting. This cannot be set in the Edit 3D Shape screen.

Show texture Enables textures. This cannot be set in the Edit 3D Shape screen.

No back-face culling Displays/hides the back faces of a surface.

Curved surface Displays/hides curved surfaces.

Wireframe Displays 3D models only as wires.

Show outline Displays the outlines of 3D models.

Show shadow Displays the shadows of 3D models.

To display the [View Settings] palette again, select [Window] menu → [View Settings].
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Material Palette
This section describes the functions, operations and materials of the [Material] palettes.

 Materials that Can be Used in CLIP STUDIO MODELER

 Functions of Material Palettes

 Using Materials

 Searching for a Material



Material Palettes > Materials that Can be Used in CLIP STUDIO MODELER
Material Palettes

 Materials that Can be Used in CLIP STUDIO 
MODELER

A list of materials that can be used in all CLIP STUDIO products is displayed in the [Material] palette. The following
materials can be used in CLIP STUDIO MODELER.

Folder in the default tree view Details

3D

Pose

Contains pose materials for 3D characters.

Pose materials can be imported from [Add from material] in the [Character configuration] 
palette of the 3D Character Setup screen and applied to a 3D character. For information on 
how to operate pose materials, see "Creating and Registering Poses" .

Character

Contains 3D character materials.

Drag and drop a material pre-installed in CLIP STUDIO PAINT or CLIP STUDIO MOD-
ELER or a material registered using CLIP STUDIO MODELER to the [Document] 
window. This displays the 3D Character Setup screen, where the material can be edited.

Small object

Contains 3D object materials.

Drag and drop a material pre-installed in CLIP STUDIO PAINT or CLIP STUDIO MOD-
ELER or a material registered using CLIP STUDIO MODELER to the [Document] 
window. This displays the 3D Object Setup screen, where the material can be edited.

Background

Contains 3D object materials (3D background materials).

Drag and drop a material pre-installed in CLIP STUDIO PAINT or CLIP STUDIO MOD-
ELER or a material registered using CLIP STUDIO MODELER to the [Document] 
window. This displays the 3D Object Setup screen, where the material can be edited.

Character parts

Contains part materials for creating characters in CLIP STUDIO MODELER. There are 
three types: [Body], [Face] and [Hair]. The position and size can be adjusted with the 
[Move parts] tool.

Character part materials can be imported from [Add from material] in the [Character 
configuration] palette of the 3D Character Setup screen and edited.

Character textures
Contains textures to paste to characters created in CLIP STUDIO MODELER. The 
position and size can be adjusted with the [Texture] tool.

These can be used in the 3D Character Setup screen.

Download Displays materials downloaded from the CLIP server using CLIP STUDIO.
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Material Palettes > Functions of Material Palettes
 Functions of Material Palettes
This section describes the functions of the [Material] palettes.

A. Tree View
Displays the [Material] folders in the palette hierarchically. Double clicking the folder or folder name part expands the sub-folders.

B. Tag List
Displays tags assigned to materials as a list of buttons. It also allows for keyword input to search for a material.

(1) Search box
Input a keyword to search for a material registered in the currently open [Material] palette.

 A list of materials that can be used in all CLIP STUDIO products is displayed in the [Material] palette.

 For details on materials that can be used in CLIP STUDIO MODELER, see  → "Materials that Can be Used in 
CLIP STUDIO MODELER" .

 Materials downloaded from the CLIP server using CLIP STUDIO are registered in the [Download] folder.

 CLIP STUDIO can be started by selecting [Start CLIP STUDIO] in the Command Bar.
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Material Palettes > Functions of Material Palettes
(2) Tag list
A list of tags assigned to materials displayed as buttons. Clicking a button displays the included materials in [Material list].

C. Material List
Displays the list of materials registered in the currently open [Material] palette folders. Materials can be selected from the list and pasted in 
the [Document] window. You can also open the [Material property] dialog box and configure various settings for the material.

(1) Material list
Displays the list of materials registered in the currently open [Material] palette folders.

(2) Thumbnail size
Select the size of thumbnails displayed in the [Material list] from [Large], [Small] and [Detail].

(3) Material property
Cannot be used.

(4) Delete material
Deletes the material selected on the [Material list].

For details on materials that can be used in CLIP STUDIO MODELER, see  → "Materials that Can be Used in CLIP 
STUDIO MODELER" .

A cloud icon with an arrow may be displayed in the top right corner of a material. This icon is displayed if the 
material data only exists in the cloud. A confirmation message is displayed when you drag and drop the material 
to the canvas. Click [Yes] to start CLIP STUDIO and start downloading the material. After downloading, the mate-
rial can be used as normal.  

 For information on how to paste materials, see "Using Materials" .

 [Show all the materials in the folder] in the [Material list] is used to clear the search conditions.
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Material Palettes > Functions of Material Palettes
Material Palette Menu
This section describes the functions included in the menu that displays when you click [Palette menu] on the upper left corner of the [Material] 
palette.

Hide material palette
Hides the [Material] palette.

Operating the Tree View
To edit the [Tree view] folder, proceed as follows.

Adding a Folder to the Tree View
Select the folder and right click to display the menu. Selecting [Create new] from the menu creates a new folder in the selected folder.

Deleting a Folder from the Tree View
Select the folder and right click to display the menu. Select [Delete] from the menu. Clicking [Yes] on the dialog box confirming deletion 
deletes the selected folder.

To display the [Material] palette again, select [Window] menu → [Material].

 Default folders cannot be deleted.

 Deleting a folder deletes the materials inside.

Show Menu
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Material Palettes > Functions of Material Palettes > Operating the Tree View
Renaming a Folder in the Tree View
Select the folder and right click to display the menu. Select [Change name] from the menu to change the name of the selected folder.

Moving a Folder in the Tree View
To move a folder, select the folder and drag and drop it to the desired position.

Default folders cannot be renamed.

Default folders cannot be moved.
CLIP STUDIO MODELER USER GUIDE 226



Material Palettes > Functions of Material Palettes > Operating the Tree View
Moving Materials of Another Folder
To move a material to another folder, select the material on the [Material list] and drag and drop it to the other folder on the [Tree view].
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Material Palettes > Using Materials > Importing materials
 Using Materials
This chapter describes how to import materials.

Importing materials
The way to import a material varies depending on the selected material.

Character texture materials
This section explains how to paste character texture materials from the [Material] palette in the 3D Character Setup screen.

1 Select the tool
Select the [Texture] tool from the [Tool] palette and select the [Paste texture] sub tool from the [Sub Tool] palette.

2 Import the material
Drag and drop a character texture material from the [Material] palette to [Texture image] in the [Tool Property] palette.

A preview is displayed in [Texture image] when the character texture material is imported.

Character texture materials can also be imported by dragging and dropping from the [Material] palette to [Import 
texture] in the [Character information] palette.
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Material Palettes > Using Materials > Importing materials
3 Select the part
Select the [Face parts folder] where you want to paste the character texture material from the [Character configuration] palette.

(1) Select [Face] from the group on the [Character configuration] palette.

(2) Select the [Face parts folder] where you want to paste the character texture material.

4 Pasting a texture
Drag in the [Document] window to make a rectangle surrounding the area where you want to paste the character texture material.

5 The character texture material is added
The character texture material is added in the [Additional texture folder] in the [Face parts folder] in the [Character configuration] palette.

When a character texture material is pasted, the display automatically switches to the [Move texture] sub tool, 
allowing you to adjust the position and size of the character texture material.

Drag
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Material Palettes > Using Materials > Importing materials
3D materials
This section explains how to import 3D materials pre-installed in CLIP STUDIO PAINT.

3D object materials, 3D background materials and 3D character materials can be imported as 3D materials. Materials set up in CLIP STUDIO 
MODELER and registered to CLIP STUDIO can be used in the same way.

Drag and drop a 3D material from the [Material] palette to the [Document] window.

A new setup screen is created for the material and the material is imported.

3D materials set up using CLIP STUDIO COORDINATE and 3D materials compatible with Ver.1.5 cannot be 
imported in CLIP STUDIO MODELER.

The 3D Character Setup screen is displayed 

and the 3D character material is imported.
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Material Palettes > Searching for a Material > Searching from the search box
 Searching for a Material
Searching for a material is possible from the [Search box] or the [Tag list].

Searching from the search box
Input a keyword to search for a material registered in the currently open [Material] palette.

How to use keywords
 Input a material name or tag name for keyword.

 Words partially matching the keyword can also be searched.

 Words including spaces can be searched by enclosing them between double quotation marks (").

 Search is not sensitive to hiragana and katakana.

Specifying multiple keywords
Specifying multiple keywords using a space as separator will allow you to narrow down the search results.

For example, assuming that there are two materials having "smile" in its name, and that

the [Tag] of one of them contains "male" and that of the other contains "female",

inputting "smile" displays both materials in the results. Inputting "smile female" displays only the material with "smile" in its [Material name], 
and "female" in its [Tag] in the results.

Searching from the tag list
Turning on a button on the [Tag list] displays materials with the same tag on the [Material list].

The [Search box] and [Tag list] can be used in combination for a search.

To clear the search conditions, use [Show all the materials in the folder] inside the [Material list].

To clear the conditions for searching the tag list, proceed as follows:

 Click the button again.

 Click [Show all the materials in the folder] inside the [Material list].

Search box

Tag ListTTT
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Menu
This section explains the menu in CLIP STUDIO MODELER.

 CLIP STUDIO MODELER Menu [macOS]

 File Menu

 Edit Menu

 View Menu

 Window Menu

 Help Menu



Menu > CLIP STUDIO MODELER Menu [macOS] > About CLIP STUDIO MODELER [macOS]
Menu

 CLIP STUDIO MODELER Menu [macOS]
This section explains the functions in CLIP STUDIO MODELER's menu.

About CLIP STUDIO MODELER [macOS]
Displays a screen with product information about CLIP STUDIO MODELER. You can check information such as the version of CLIP STU-
DIO MODELER that you are currently using.

Version Information [mac OS]
Displays a screen with product information about CLIP STUDIO MODELER. You can check information such as the version of CLIP STU-
DIO MODELER that you are currently using.

Start CLIP STUDIO [mac OS]
Start CLIP STUDIO. CLIP STUDIO supports creative activities.

Quit CLIP STUDIO MODELER [macOS]
Quits CLIP STUDIO MODELER.
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Menu > File Menu > New
 File Menu
The [File] menu is mainly for performing file input/output operations.

New
Select this to display the [New] dialog box. Select the type of work and click [OK] to create a new work.

New dialog box

(1) New 3D object
The 3D Object Setup screen can be selected. In 3D object setup, you can load 3D data and set up a 3D object material that can be used in 
CLIP STUDIO PAINT.

(2) New 3D character
Select a 3D Character Setup screen. In the 3D character setup screen, you can load 3D data and set up a 3D character material that can be 
used in CLIP STUDIO PAINT.

(3) Display this dialog box when CLIP STUDIO MODELER is started
Turn this on to display the [New] dialog box when CLIP STUDIO MODELER is started.

(4) Create (selected item)
Click this to display a setup screen or editing screen for the item selected in (1) to (2).

(5) Close
Closes the [New] dialog box.
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Menu > File Menu > Open
Open
Specify the file you want to open in CLIP STUDIO MODELER from the dialog box.

Close
Closes the edited file.

Save
Saves the edited file under the same name. The file name and save location are specified only when saving for the first time.

The formats in which the file can be saved differ depending on the displayed screen.

Save as
Saves the edited file under a new name, creating a new file.

The formats in which the file can be saved differ depending on the displayed screen.

File formats that can be 
imported

CLIP STUDIO MODELER character files (extension: csmc)

CLIP STUDIO MODELER object files (extension: csmo)

CLIP STUDIO MODELER background files (extension: csms)

CLIP STUDIO 3D character files (extension: cs3c)

CLIP STUDIO 3D object files (extension: cs3o)

CLIP STUDIO 3D background files (extension: cs3s)

3D Object Setup screen
CLIP STUDIO MODELER object files (extension: csmo)

CLIP STUDIO 3D object files (extension: cs3o)

3D Character Setup screen
CLIP STUDIO MODELER character files (extension: csmc)

CLIP STUDIO 3D character files (extension: cs3c)

 To use files in CLIP STUDIO MODELER format (extension: csmf) in CLIP STUDIO PAINT, import the saved file 
in the material setup screen and save it.

 For information on formats that files can be saved in and saving methods that can be used in the material 
setup screen, see "Saving a 3D Object"  and "Saving a 3D Character" .

3D Object Setup screen
CLIP STUDIO MODELER object files (extension: csmo)

CLIP STUDIO 3D object files (extension: cs3o)

3D Character Setup screen
CLIP STUDIO MODELER character files (extension: csmc)

CLIP STUDIO 3D character files (extension: cs3c)

 To use files in CLIP STUDIO MODELER format (extension: csmf) in CLIP STUDIO PAINT, import the saved file 
in the material setup screen and save it.

 For information on formats that files can be saved in and saving methods that can be used in the material 
setup screen, see "Saving a 3D Object"  and "Saving a 3D Character" .
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Menu > File Menu > Register as new material
Register as new material
Converts a 3D model created in CLIP STUDIO MODELER into a 3D material that can be used in CLIP STUDIO products.

Select an item in the menu to display the [Material property] dialog. Input material information and click [OK] to register the 3D material to 
CLIP STUDIO.

The type of material that can be registered depends on the screen that is displayed.

Material property dialog box
The following describes the [Material property] dialog box.

(1) Material name
Input a name for the material. "New document" is displayed if nothing is input. The material name can be changed in this dialog box.

(2) Material image
Displays a thumbnail of the material. The content displayed on the thumbnail differs depending on the material.
 The display of the [Document] window is applied to the Edit 3D Shape screen.
 The content captured in [Capture thumbnail] mode is displayed in the material setup screen.

3D Object Setup screen 3D Object Materials

3D Character Setup screen 3D Character Materials

3D shape materials can only be used in CLIP STUDIO MODELER. They cannot be used in CLIP STUDIO PAINT.

CLIP STUDIO supports creative activities.

For information on capturing thumbnails in the material setup screen, see "Capturing a Thumbnail" .
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Menu > File Menu > Overwrite and close material
(3) Location to save material
Click a folder to specify the location where you want to save the material. The specified location is reflected in the [Tree view] of the 
[Material] palette.

(4) Search tag
Click the tag list to specify the search tag to be displayed on the [Tag list].
 Clicking the tag with a + sign in the lower right will allow you to create a new tag.
 When a search tag is clicked, it changes color Light blue indicates that the tag is specified as a search tag for the material. White indi-

cates that the tag is not specified as a search tag.
 To delete a tag, move the mouse cursor to the tag. A "×" mark appears on the right side of the tag. Click the "×" mark to delete the tag.

Overwrite and close material 
The 3D material edited in the Edit Material mode of CLIP STUDIO MODELER is saved under the same name and CLIP STUDIO MODELER 
is closed.

Edit Material mode is a mode for editing 3D materials registered in CLIP STUDIO.

Open CLIP STUDIO and select the 3D material you want to edit. Open the information screen of the material and click [Open in MODELER] 
to open CLIP STUDIO MODELER in Edit Material mode.

Start CLIP STUDIO [Windows]
Start CLIP STUDIO. CLIP STUDIO supports creative activities.

Quit CLIP STUDIO MODELER [Windows]
Quits CLIP STUDIO MODELER.

Only materials set up in CLIP STUDIO MODELER and registered to CLIP STUDIO can be saved under the same 
name. Preinstalled materials and materials downloaded in CLIP STUDIO cannot be saved under the same name.

This item is not displayed in the 3D shape editing screen.
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Menu > Edit Menu > Undo
 Edit Menu
The [Edit] menu is used to edit mesh, faces and edges.

Undo
Undoes the last shape transformation performed and restores the shape to its previous state.

Redo
Select this after undoing an action to redo the action.
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Menu > View Menu > Undo point of view
 View Menu
This is used to adjust settings such as [How to show] in the [Document] window.

Undo point of view
Undoes changes to the viewing angle or viewing position made with the [Magnifier] or [Camera] sub tool.

Redo point of view
Redoes changes to the viewing angle or viewing position that were undone from the [View] menu → [Undo point of view].

View entire object
Adjusts the view so that all of the mesh fits in the [Document] window at the current viewing angle.

Return to initial viewing angle
Restores the initial viewing angle and viewing position.

Make selected area center of display rotation
Makes the center of the selected mesh or area the center of rotation when performing camera orientation operations.

Wireframe
Turn this on to display 3D models only as wires.

Outline
Turn this on to display the outlines of 3D models.

Shadow
Turn this on to display the shadows of 3D models.

Lighting
Turn this on to apply light source settings to 3D models.

Textures
Turn this on to display the textures of 3D models.

Culling
Turns culling on or off. Select from [Culling (Frontface)], [Culling (Backface)] and [No culling].

 If multiple mesh items are selected, the center point between the selected mesh items is the center of rotation.

 Camera orientation operations can be performed using the [Camera orientation] sub tool.

This item is not displayed in the 3D shape editing screen.
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Menu > View Menu > Bone
Bone
Turn this on to display the bones of 3D models.

Physics object 
Turn this on to display physics objects for 3D characters.

This item is not displayed in the 3D Object Setup screen or 3D shape editing screen.
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Menu > Window Menu > Document
 Window Menu
The [Window] menu is for performing operations related to the windows.

Document
Various operations related to the [Document] window can be performed.

Cascade
When multiple [Document] windows are displayed separately, this function displays them on top of each other.

Tiled
When multiple [Document] windows are displayed separately, this function displays them alongside each other.

Multiple windows are displayed on top of each other.

Multiple windows are displayed 

alongside each other.
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Menu > Window Menu > Workspace
Workspace
The palette layout is called a workspace. This section describes settings related to the workspace.

Reset to Default
Returns the palette layout to its initial status.

Command Bar
Displays/hides the [Command Bar].

Tool
Displays/hides the [Tool] palette.

Sub Tool
Displays/hides the [Sub tool] palette.

Tool Property
Displays/hides the [Tool Property] palette.

Navigator
Displays/hides the [Navigator] palette.

Camera settings
Displays/hides the [Camera settings] palette.

View Settings
Displays/hides the [View Settings] palette.

Object configuration
Displays/hides the [Object configuration] palette.

Object information
Displays/hides the [Object information] palette.

Character configuration 
Displays/hides the [Character configuration] palette.

This item is not displayed in the 3D Character Setup screen or 3D shape editing screen.

This item is not displayed in the 3D Character Setup screen or 3D shape editing screen.

This item is not displayed in the 3D Object Setup screen or 3D shape editing screen.
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Menu > Window Menu > Character information
Character information 
Displays/hides the [Character information] palette.

Material 
Displays/hides the [Material] palettes.

Show/Hide All Palettes
Displays/hides the currently displayed [palettes].

This item is not displayed in the 3D Object Setup screen or 3D shape editing screen.
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Menu > Help Menu > Manual
 Help Menu
This section explains the functions in CLIP STUDIO MODELER's [Help] menu.

Manual
Select this to open your web browser and display the CLIP STUDIO MODELER manual.

Training and Tutorials
Select this to open your web browser and display CLIP STUDIO MODELER Training and Tutorials.

Support
Select this to open your web browser and display the CLIP STUDIO MODELER support website.

This website has answers to frequently asked questions, along with a message board where you can post questions and requests about CLIP 
STUDIO MODELER.

Graphics performance check
Select this to check whether your computer's graphics performance is suitable for CLIP STUDIO MODELER.

The check results will provide information such as hints to improve the graphics performance.

.

About CLIP STUDIO MODELER [Windows]
Displays a screen with product information about CLIP STUDIO MODELER. You can check information such as the version of CLIP STU-
DIO MODELER that you are currently using.

Version information [Windows]
Displays a screen with product information about CLIP STUDIO MODELER. You can check information such as the version of CLIP STU-
DIO MODELER that you are currently using.
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Shortcut List
Below is a list of the shortcuts set by default in CLIP STUDIO MODELER.

 Menu Shortcuts



Shortcut List > Menu Shortcuts > CLIP STUDIO MODELER Menu [macOS]
Shortcut List

 Menu Shortcuts
Menu shortcuts are as follows.

CLIP STUDIO MODELER Menu [macOS]
Below are the [CLIP STUDIO MODELER] menu shortcuts.

File Menu
Below are the [File] menu shortcuts.

Edit Menu
Below are the [Edit] menu shortcuts.

In the English version, menu commands not displayed in the software are not available as shortcuts.

Menu item Shortcut key

About CLIP STUDIO MODELER [macOS]

Version Information [mac OS]

Start CLIP STUDIO [mac OS]

Quit CLIP STUDIO MODELER [macOS] Cmd+Q

Menu item Shortcut key

New Ctrl+N

Open Ctrl+O

Close Ctrl+W

Save Ctrl+S

Save as Shift+Alt+S

Register as new material

Overwrite and close material

Start CLIP STUDIO [Windows]

Quit CLIP STUDIO MODELER [Windows] Ctrl+Q

Menu item Shortcut key

Undo Ctrl+Z

Redo Ctrl+Y
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Shortcut List > Menu Shortcuts > View Menu
View Menu
Below are the [View] menu shortcuts.

Window Menu
Below are the [Window] menu shortcuts.

Menu item Shortcut key

Undo point of view Ctrl+Alt+X

Redo point of view Ctrl+Alt+Y

View entire object Ctrl+Alt+0

Return to initial viewing angle Ctrl+@

Wireframe

Outline

Shadow

Lighting

Texture

Culling

Culling (Frontface)

Culling (Backface)

No culling

Bone

Physics object

Menu item Shortcut key

Document
Cascade

Tiled

Workspace Reset to default

Command Bar

Status bar

Tool

Sub Tool

Tool Property

Navigator

Camera settings

View Settings

Object configuration

Object information

Character configuration 
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Shortcut List > Menu Shortcuts > Help Menu
Help Menu
Below are the [Help] menu shortcuts.

Character information 

Material 

Show/Hide All Palettes Tab

Menu item Shortcut key

Manual F1

Training and Tutorials

Support

Graphics performance check

About CLIP STUDIO MODELER [Windows]

Version information [Windows]

Menu item Shortcut key
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